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法律资讯 
警告提示系统 

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅

与财产损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。 

 危险 

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。 
 

 警告 

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。 
 

 小心 

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。 
 

 注意 

表示如果不采取相应的小心措施，可能导致财产损失。 

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导

致人身伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。 

合格的专业人员 
本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说

明，特别是其中的安全及警告提示。 
由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危险。 

按规定使用Siemens 产品 
请注意下列说明： 

 警告 

Siemens 
产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 
推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。必

须保证允许的环境条件。必须注意相关文件中的提示。 

商标 
所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。

若第三方出于自身目的使用这些商标，将侵害其所有者的权利。 

责任免除 
我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保

证印刷品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一

版本中。 
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 任务 1 
 

简介  

欢迎使用“IndustrialDataBridge V7.3 入门指南”。 入门指南使用示例项目来介绍 IDB V7.3 
的一些简单操作。本入门指南以各种实例来讲解 IndustrialDataBridge 
的整个组态过程并以这些实例在运行系统中实现数据传送过程。  

随附的 WinCC 项目“idb_getting_started.MCP”和 IDB 
入门指南项目“IndustrialDataBridge”为您提供了一个环境，可帮助您快速上手 
IndustrialDataBridge 应用程序。 

 
 

 
说明 

语言 
入门指南示例仅提供英文版。 在 WinCC 项目管理器或 IDB V7.3 
中，即使更改语言，您可以注意到入门指南示例在 WinCC Runtime 中仍以英文显示。 

 

示例项目 

本入门指南附带的示例项目中包括 2 个示例。 

 

示例 1  

本示例演示了如何在工厂环境中传送数据。 
本示例演示了过程值归档到用户归档的数据传送过程。 
过程值归档中的已归档报警数据还可以保存到 CSV 文件。 
包含更新数据的用户归档将传送到 OPC Data Access。 

 

示例 2 

本示例介绍了一个使用配方的简单生产过程。 
该示例演示了工厂环境下的某个具体环节。 
在该示例中，工件数量，包括配方数据（即颜料特性及加工数量等信息）都从数据库中检

索。 此信息会存储在用户归档中。因此，可以考虑开始生产过程。 
生产完成后，生产的结果将输入到文本框字段。 



任务  
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输入的信息将存储在另一个用户归档中。 IDB 
应用程序将确保在数据传送过程中，输入的结果成功传送到数据库中。 

  

任务 

您将了解以下步骤： 

● 在 IDB CS 中，创建项目、链接，以及执行链接设置和连接。 

● 在 IDB Runtime 中使用初始化数据传送所需的组态。 

● 在 WinCC Runtime 中，打开入门指南项目 
(idb_getting_started.MCP)，激活项目并查看入门指南示例。 

 

 
 

 
说明 
在后续章节中，选件“IndustrialDataBridge”将以缩写形式 IDB 来表示。 

 

步骤 

执行下列步骤来完成“入门指南”。 后续章节列出了执行这些步骤的具体过程。 

1. 在 IDB 中创建并组态链接；导出 XML 文件。 

2. 安装 WinCC 项目“IDB_Getting_Started”。 

3. 在 WinCC 项目中定义计算机属性。 

4. 从 WinCC 项目中导出参考 XML 文件。 

5. 激活 WinCC 项目。 

6. 针对 WinCC 项目调整参考组态。 

7. 为“入门指南”项目准备环境。 

8. 启用数据传送并启动配方数据的下载和上传。 
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 先决条件 2 
 

简介 

本章介绍了使用入门指南所需的硬件要求和软件要求的相关信息。 IDB 
信息系统的“WinCC/IndustrialDataBridge 安装注意事项”一章中提供了 
IndustrialDataBridge V7.3 的先决条件。  

 

可通过导航到下述文件夹路径来访问 IDB 信息系统。 

“C:\Program Files (x86)\Siemens\Automation\IndustrialDataBridge\Help\” 

硬件要求 

“入门指南”项目对硬件的要求与其它 IDB 项目相同。 遵守 IDB V7.3 安装注意事项。 

软件要求 

“入门指南”项目对软件的要求与其它 IDB 项目相同。 遵守 IDB V7.3 安装注意事项。 

还需要满足以下条件： 

● 已安装 WinCC V7.3。 

● 已安装 IDB V7.3。 

 



先决条件  
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 WinCC 项目 3 
3.1 概述 

概述 

WinCC 项目“idb_getting_started”提供了通过 IDB 来传送的数据。 
该传送通过单击一个按钮创建的触发器事件来触发。 
发生触发器事件时，数据按该组态进行传送。 
此过程通过以下示例演示：在入门指南示例 1 中，使用过程值进行数据传送，示例 2 
包括一个配方示例，其利用了一个简单的工厂生产环节。 
“入门指南”示例使用“idb_getting_started.xml”作为参考组态文件。 

WinCC 项目的结构 

此 WinCC 项目专为 IndustrialDataBridge V7.3 准备一个环境而开发。因此，此 WinCC 
项目只包含以下元素： 

● 包含按钮、选择字段、输入字段和显示字段的起始画面。 

● IDB 访问“入门指南”项目的数据库。 

 

“idb_getting_started”文件夹中包含 idb_getting_started.MCP 文件以及 WinCC 
项目所需的其它资源。 在 WinCC 中激活“入门指南”项目后，便可在 WinCC Runtime 
中查看这些示例。 

 

使用 IndustrialDataBridge CS 所需的项目和数据库以及 XML 
文件可从以下位置的“IndustrialDataBridge”文件夹获取： 

Windows 7/Windows 8/Windows Server 2008/Windows Server 2012 操作系统： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Ind
ustrialDataBridge\”   

 

安装后，您需要调整 WinCC 项目中的计算机属性，例如，计算机名称和路径。 4.2 
节“为入门指南准备环境” (页 10)对此进行了描述。 
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3.2 为“入门指南”项目准备环境 

简介 

本章介绍使用 WinCC 
调整计算机属性的步骤并列出打开“idb_getting_started”项目需要执行的具体步骤信息。 
因此，在 WinCC 中激活项目后，WinCC Runtime 显示“入门指南”示例。 

先决条件 

● 已在安装 IDB V7.3 期间安装“入门指南”项目。 

● 计算机上已安装 IDB 组态系统和 IDB Runtime 应用程序。 

● 已安装 WinCC V7.3。 

在 WinCC 中调整计算机属性 

要在安装 WinCC 的计算机中使用“入门指南”项目，需要调整计算机属性。 
按以下步骤调整计算机属性： 

1. 启动 WinCC 项目管理器。 

2. 在 WinCC 项目管理器窗口中，选择“文件 > 打开”(File > 
Open)，然后从“入门指南”的安装位置选择 idb_getting_started.MCP 文件。 

 
  

说明 

“入门指南”项目文件夹 
如果已选择“入门指南”项目作为 IDB V7.3 安装的一部分，它会安装在以下位置： 
Windows 7/Windows 8/Windows Server 2008/Windows Server 2012 操作系统： 
“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\”  
 
MCP 文件及其它“入门指南”资源均位于此文件夹。 

 

 

3. 将显示“本地启动服务器”(Start server locally) 按钮。 单击“本地启动服务器”(Start 
server locally) 接受本地计算机名称。 
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4. 但需要在 WinCC 项目管理器中调整计算机属性来体现这些更改。 

– 在 WinCC 项目管理器中，右键单击“计算机”(Computer) 
图标，然后选择“属性”(Properties) 选项。 将显示“计算机列表属性”(Computer list 
properties) 窗口。 

– “计算机列表属性”(Computer List Properties) 窗口在“计算机列表”(Computer List) 
字段显示一组计算机的列表。 选择计算机名称，然后选择“属性”(Properties) 
按钮打开“计算机属性”(Computer properties) 对话框窗口。 

– 本地计算机名称将显示在“计算机名称”(Computer Name) 字段旁的文本框中。 
单击“使用本地计算机名称”(Use Local Computer Name) 
按钮，然后选择“确定”(OK)。 

– 然后单击“确定”(OK) 保存更改。 这会关闭“计算机列表属性”(Computer List 
Properties) 窗口。 

5. 在 WinCC 项目管理器中关闭已打开的项目，然后重新启动 WinCC 使更改生效。 

6. 重启 WinCC 之后，在 WinCC 
项目管理器中通过选择“idb_getting_started.MCP”文件打开 IDB 项目。 

7. 下一步，在 WinCC 中激活 IDB 入门指南项目“idb_getting_started”。 
您会观察到，“入门指南”示例将在 WinCC Runtime 中自动启动。 

在 WinCC 中导出 XML 文件 

要让 WinCC OLEDB 访问 WinCC 用户归档，需要从已安装 WinCC 的计算机导出 XML 
文件。 使用过程归档或消息归档时，此 XML 导出文件可用于将 WinCC OLEDB 
组态为提供方。 
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按以下步骤在 WinCC 中导出 XML 文件： 

1. 启动 WinCC 项目管理器。 

2. 打开 MCP 文件“idb_getting_started.MCP”并激活项目。 

3. 在 WinCC 项目管理器左侧导航区域，右键单击“IndustrialDataBridge”，然后选择“项目 
XML 导出”(Project XML Export) 选项导出 XML 文件。 

4. XML 文件可导出到以下路径： 

Windows 7/Windows 8/Windows Server 2008/Windows Server 2012 操作系统： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\
IndustrialDataBridge\Reports”   
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结果 

您已经为使用 IndustrialDataBridge“入门指南”示例准备好所需的环境。 要使用 WinCC 
控件访问 IDB Runtime，请参见 4.3 节“使用 WinCC 访问 IDB Runtime”。 
有关使用给定示例启用数据传送的相关步骤，请参见第 6 章“入门指南和示例” (页 23)。 
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3.3 使用 WinCC 控件访问 IDB Runtime 

概述 

WinCC IDB Runtime 应用程序可通过 WinCC 控件访问。 以上可通过在图形设计器中将 
WinCC ActiveX 控件“IDB Runtime 控件”添加为 OCX 来实现。 借此，用户可在 WinCC 
环境中启动 IDB Runtime。 

作为 OCX 的 IDB Runtime，其外观和使用体验与作为可执行文件的 IDB 
运行系统大同小异。 但是，作为 OCX 的 IDB Runtime 
有小幅的改动，具体内容请参见后续章节。 

访问 IDB Runtime 

要在 WinCC 中访问作为 ActiveX 控件的 IDB Runtime 控件，请遵循以下步骤： 

1. 启动 WinCC 项目管理器。 

2. 在 WinCC 项目管理器中，在导航窗口双击“图形编辑器”元素以打开图形编辑器。 

3. 在图形编辑器中，选择“文件 > 新建”(File > New) 创建一个新的 PDL 文件。 

4. 导航至“对象选项板”(Object Palette) 并选择“控件”(controls) 选项卡。 
在列表中突出显示“ActiveX 控件”(ActiveX controls)。 

5. 展开 ActiveX 控件树以查看可用控件列表。 

 
  

说明 
如果展开列表后无法查看控件，右键单击“ActiveX 控件”(ActiveX controls) 
并选择“添加/删除”(Add/Remove) 选项。 “选择 OCX 控件”(Select OCX Controls) 
窗口将显示出来，其中包含一个可用控件列表。 选择“IDB Runtime 控件”(IDB 
Runtime control) 并单击“确定”(OK)。 

 

6. IDB Runtime 控件应作为一个 OCX 列在控件列表中。 

7. 将此 OCX 控件拖放到 PDL 文件窗口中的盛放区域中。 

8. 在此控件添加到盛放区域后，保存该 PDL 
文件并在标准工具栏中单击运行系统控件以激活运行系统模式。 

9. IDB Runtime 控件随即将在 WinCC 运行系统屏幕上显示/打开。 
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按钮和视图 

对于作为 OCX 的 IDB Runtime，其工具栏按钮和视图与 IDB Runtime 
应用程序的完全一样。 “跟踪”(Trace) 视图和“状态”(Status) 视图提供在“IDB Runtime 
应用程序”(IDB Runtime Application) 窗口中。 

  
 

 
说明 

视图 
“视图”一章提供的屏幕截图对于用作 OCX 控件的 IDB Runtime 无效。 在 WinCC 
中访问用作 ActiveX 控件的 IDB Runtime 时，可以看到 IDB Runtime 菜单栏将不显示。  

 



WinCC 项目  
3.3 使用 WinCC 控件访问 IDB Runtime 

 WinCC/IndustrialDataBridge 入门指南 
16 入门指南, 5/2014 

 
说明 

“密码检查”(Password check) 和“跟踪记录”(Trace logging) 选项 
IDB Runtime 应用程序的“选项”(Options) 菜单中的“密码检查”(Password check) 
和“跟踪记录”(Trace logging) 菜单项，已分别作为单独复选框而在“密码”(Password) 
选项卡和“跟踪”(Trace) 选项卡上提供。 

 

 

  

选项 

在 IDB Runtime 应用程序中选择“选项”(Options) 工具栏按钮以访问运行系统组态。 
“运行系统组态”提供以下选项卡： 

● 启动选项 (Startup Option) 

● 跟踪 

● 密码 

● 许可证 

● NT 服务 

 
 

 
说明 
只有在 IDB 服务已启动时，才能对运行系统界面进行更改。 

 

 

这些选项卡所提供的选项与 IDB Runtime 应用程序中的选项完全相同。 但作为 WinCC 
控件的 IDB Runtime 还提供了一些其他功能。 这些功能具体如下： 

 

IDB Runtime 应用程序菜单： 

IDB Runtime 应用程序窗口不包括基于菜单的导航。 
所需操作可通过应用程序工具栏中的 GUI 按钮执行。 

 

 



 WinCC 项目 
 3.3 使用 WinCC 控件访问 IDB Runtime 

WinCC/IndustrialDataBridge 入门指南 
入门指南, 5/2014 17 

语言选项： 

IDB Runtime 应用程序提供语言支持。 它支持 7 种语言 - 
英语、西班牙语、德语、意大利语、中文、日语和法语。 当访问 WinCC 
运行系统屏幕上作为 OCX 控件的 IDB Runtime 时，所显示的语言会随着 WinCC 
Runtime 使用的语言而发生更改。  

IDB 运行系统控件的语言选项不会链接到 IDB Runtime 应用程序或任何其它 IDB 
运行程序控件。 也就是说，IDB 运行系统控件中的语言更改不会影响其它控件或 IDB 
Runtime 应用程序的语言，反之亦然。 

 

跟踪记录： 

“跟踪”(Trace) 选项卡在“启动”(Startup) 选项卡旁边。 此选项卡只有在“IDB 
Runtime”窗口中已加载组态文件后才会显示。 

“跟踪记录”(Trace Logging) 复选框位于运行系统组态窗口的“跟踪”(Trace) 选项卡中。 
启用该复选框后，可保存由提供方和消费方生成的跟踪消息。 在“跟踪”(Trace) 
选项卡中，“提供方日志文件”和“消费方日志文件”部分均提供了相应选项，可为记录跟踪

消息指定相应的文件名。 这些跟踪日志文件可供以后查看这些跟踪消息时使用。 

 

 

 

密码检查： 

“密码检查”(Password Check) 复选框在运行系统组态窗口的“密码”(Password) 
选项卡中提供。 启用该复选框后，每次在“运行系统组态”(Runtime Configuration) 
任一选项卡中执行操作时，都将生成一个对话框并将要求您输入密码。 
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“打开”对话框： 

借助“打开”(Open) 按钮和“启动选项”(Startup Option) 
选项卡中提供的选项，可选择用于在运行期间激活连接的组态 XML 文件。 
选择“浏览”(Browse) 按钮以调用“打开”(Open) 对话框窗口。 
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在用作 OCX 的 IDB Runtime 中，以下几点适用于在“打开”(Open) 对话框中执行的动作。 

● “打开”(Open) 对话框仅以“读取”模式打开。 只能打开 XML 文件。 

● 此对话框中未提供删除文件或文件夹的选项。 

● 未提供剪切/粘贴文件或文件夹的选项，同时也不可创建新文件/文件夹。 

● 该窗口区域中不支持右键单击弹出菜单。 

● 不能在该对话框中拖放文件或文件夹。 

● 不支持 F2 键重命名文件或文件夹。 
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 IDB 项目 4 
4.1 概述 

概述 

“IndustrialDataBridge”项目提供了操作入门指南示例所需的资源。 如果已在 IDB V7.3 
安装期间选择“入门指南”项目，它会安装在以下位置： 

Windows 7/Windows 8/Windows Server 2008/Windows Server 2012 操作系统： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\”   

 

“IndustrialDataBridge”文件夹包含 IDBProject、XML 文件、Access 
数据库以及运行示例所需的其它资源。 
可从以下文件夹位置访问“IndustrialDataBridge”项目： 

Windows 7/Windows 8/Windows Server 2008/Windows Server 2012 操作系统： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Ind
ustrialDataBridge\”   

 

“IndustrialDataBridge”文件夹中包含以下文件： 

● IDBProject 

● 报表 

● getting_started_alarms.csv 

● idb_getting_started_configfile.xml 

● IDBGettingStarted.accdb 

 

 

“IDBProject”文件夹列出了在 IDB 组态系统中查看项目的所需文件。 在 IDB CS 
应用程序中打开 IDBProject 的方式有：导入“IndustrialDataBridge”文件夹中提供的 XML 
文件“idb_getting_Started_configfile.xml”或打开“IDBProject”文件夹中提供的 .ip73 
项目文件。 
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说明 

文件夹结构 
下述文件夹结构路径对应于 Windows 7/Windows 8/Windows Server 2008/Windows 
Server 2012 操作系统。 请使用下述文件夹位置导航到相应的文件或文件夹。 
 

• 包含 .ip73 和相关文件的 IDBProject： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\
IndustrialDataBridge\IDBProject” 

• 从 WinCC 导出的 XML 文件： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\
IndustrialDataBridge\Reports” 

• 包含 XML 文件、数据库和其它资源的 IndustrialDataBridge 文件夹： 

“C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\
IndustrialDataBridge\” 

 
 

 
说明 

报表 
从 WinCC 项目导出 XML 文件后，默认情况下将 XML 文件导出到“报表”(Reports) 
文件夹。 此文件夹位于“IndustrialDataBridge\Reports”文件夹中。 “报表”(Reports) 
文件夹中包括导出的 XML 文件。 

 

 

结构 

在 IDB CS 中，项目内会创建并包含一个组态文件。 
项目由链接组成，而链接包括提供方、消费方、设置和连接。 各项的定义如下： 

● 项目： 项目用于计划、组织、管理和控制 IDB CS 组态及其它设置。 

● 链接： 链接代表一个实体并包含多个连接。 

● 连接： 连接表示提供方和消费方类型之间的唯一映射关系。 
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 入门指南和示例 5 
5.1 概述 

概述 

入门指南项目使用 WinCC 项目、IDB 项目和 IDB Runtime 环境，并借助示例来演示 
IndustrialDataBridge 中的数据传送特性。 这些项目位于“idb_getting_started”文件夹中。 
入门指南示例及其功能可在 WinCC Runtime 环境下查看。 
示例项目使用过程值示例和配方示例来帮助您理解如使用 IDB V7.3 执行数据传送过程 

 
 

 
说明 
示例仅供参考，便于您理解入门指南项目。 

 

 

示例项目可帮助您在运行期间着手使用 IndustrialDataBridge V7.3 
组态界面、创建组态文件和加载组态。 还可借助简单的工厂情况了解数据传输流。 

 

入门指南项目 

入门指南项目包括 2 个示例项目。 这 2 个示例项目将分别在“入门指南示例 
1”和“入门指南示例 2”小节中进行详细介绍。  

 

● “入门指南示例 1”包括示例项目的简介并提供了项目的组态步骤。 在 WinCC Runtime 
中查看示例 1 的相关说明也包含在本章内。 

● “入门指南示例 2”包括示例项目的简介和项目的组态步骤。 在 WinCC Runtime 
中查看示例项目 2 的相关信息也包含在内。 

 

“IndustrialDataBridge”项目包括 IDBProject、XML 文件、Access 
数据库以及运行示例所需的其它资源。 
可从以下文件夹位置访问“IndustrialDataBridge”项目： 
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Windows 7/Windows Server 2008 操作系统： 

“C:\Users\Public\Public 
Documents\Siemens\IndustrialDataBridge\idb_getting_started\IndustrialDataBridge\”   

 
 

 
说明 

IDB 入门指南项目 
安装时附带的 IDB 入门指南项目中包括了用于查看示例项目的所有必要文件。 
并提供了一个事先已创建好的工作组态，可在 IDB CS 应用程序中打开。  
XML 组态文件“idb_getting_started_configfile.xml”对于这两个示例项目是通用的。  

 

 
 

 
说明 

在 WinCC 中查看示例  
包括必填字段和用户界面控件的示例可在 WinCC Runtime 环境中查看。 要在 WinCC 
中查看该示例，您需要在 WinCC 项目管理器中打开 WinCC 项目 
(idb_getting_started.MCP) 并激活相应的项目。  
入门指南示例画面中包括一个导航控件按钮，可用于在示例 1 和示例 2 之间切换。 

 

 
 

 
说明 

时区 
本说明仅针对“WinCC OLEDB 传送选项”(WinCC OLEDB transfer options) 
选项卡中的时区设置。 
如果在 Windows XP 操作系统中创建项目并在 Windows 7 或 Windows 2008 Server 
操作系统中导入组态 XML 
文件，或执行相反的操作，强烈建议您根据具体情况设置时区。 
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使用 Oracle 数据库 

入门指南示例使用 Microsoft Access 作为数据库。 此数据库包括在 IDB V7.3 DVD 
光盘的“IndustrialDataBridge”项目文件夹中。 

Windows 7/Windows Server 2008 操作系统： 

“C:\Users\Public\Public 
Documents\Siemens\IndustrialDataBridge\idb_getting_started\IndustrialDataBridge\” 

 

IndustrialDataBridge 
入门指南项目“idb_getting_started”的进入路径可从以下文件夹位置获取： 

Windows 7/Windows Server 2008 操作系统： 

“C:\Users\Public\Public Documents\Siemens\IndustrialDataBridge\”  

 

安装先决条件： 

如果要使用 Oracle 数据库，则需要在安装 IDB V7.3 的计算机中分别安装此软件。 
建议您通过驱动程序“Oracle provider for OLE DB”来安装 Oracle 10g/11g/12c。 
使用其它版本应该没问题，但并未经过测试。 

 

要使用 Oracle 12c，您需要在本地计算机上安装 Oracle 客户端，即使该计算机上已安装 
Oracle 服务器版本。 要在 IDB V7.3 中正确使用数据库，必须安装 Oracle 12c 
客户端（32 
位）。此操作将在本地计算机中注册“OraOLEDB.Oracle.1”提供方，该计算机随后将连接

到 Oracle 数据库。  

 

安装 Oracle 客户端时需要选择以下组件： 

● 可选依赖关系（Oracle 客户端） 

– Oracle provider for OLEDB 12.1.0.1.0 

 

● Oracle 客户端依赖关系 

– Oracle instant client 12.1.0.1.0 
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用户凭据： 

安装 Oracle 之后，您需要设置用户凭据。 默认情况下，创建的用户名为“anonymous”。 
在“anonymous”用户下，创建一个数据库。 输入服务名称，以将其用于数据库连接。 
在“服务器”字段中输入此服务名称。服务名称专门引用一项组态，并可在“tnsnames.ora”
文件中创建。可在此文件中找到有关主机、协议和数据库的信息。  

 

1. 在 Oracle 中创建一个数据库。 

2. 创建 2 个表格，其中 2 列需包含一些重要数据。 

3. 下一步，参照入门指南项目中提供的表格来创建含有相同字段的表格。 

4. 打开 IDB CS 应用程序并导入 XML 组态文件“idb_getting_started_configfile.xml”。 

5. 在数据库提供方中，数据库类型选择 Oracle。 在“服务器名称”(Server name) 
字段中，输入在 Oracle 中定义的服务名称。 

6. 将用户名设置为“anonymous”并输入密码。 

 
 

 
说明 

• 在提供方传送选项中，如果使用 Oracle 
作为数据库类型，将自动选择“方案名称”(Schema name)。 表格列表在“表格”(Table) 
字段中提供。 

• 执行连接映射时，请按照相应章节中的步骤操作。 
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5.2 入门指南示例 1 

5.2.1 简介 

简介 

本入门指南示例帮助您理解过程归档值和 WinCC 用户归档之间的数据传送方式。 
包含过程值的配方号可以使用示例画面中的按钮来生成，并可以在 WinCC 
用户归档中进行传送或更新。 
过程归档中已归档的报警数据可根据“起始日期”和“结束日期”进行过滤。 
根据过滤条件获得的报警数据可以更新到 CSV 文件中。 生成的配料列表最终会从 
WinCC 用户归档传送到 OPC Data Access。 入门指南示例 1 中对此进行了介绍。 

 

 
 

 
说明 

示例项目 - IDBProject 
随“入门指南”项目提供的示例包括完整的组态，其包含定义完整的组态，以及创建连接时

一并设置的提供方传送选项。 
 

 

入门指南示例 1 通过使用配方示例和执行数据传送来帮助您理解如何管理生产过程数据。 
本示例介绍了多种方式来选择可用的配方、传送警报数据和将最终的配料值发送到消费方

。 

 

示例 1 使用以下组态作为链接。 在示例 1 中，将创建 3 
个链接：Send_process_values、Send_alarm_data 和 Receive_recipe。  

您可以在 IDB CS 应用程序中查看此组态。 

● 过程归档（WinCC OLEDB 作为提供方），WinCC 用户归档作为消费方 

● 消息归档（WinCC OLEDB 作为提供方），CSV/TXT 作为消费方 

● WinCC 用户归档作为提供方，OPC 数据访问作为消费方 
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● 过程归档 - WinCC 用户归档 

通过单击按钮将用户输入的过程值（来自所选配方）传送到 WinCC 用户归档。 

● 消息归档 - CSV/TXT 

根据字段中输入的“起始日期”和“结束日期”，单击按钮将过程归档中的已归档警报数据

传送到 CSV 文件中。 

● WinCC 用户归档 - OPC Data Access 

将个别配方条目从 WinCC 用户归档传送到 OPC Data Access 中。 

 

为了便于您理解，后续章节介绍了创建或组态连接的具体相关步骤。 每章都按第 1 
步、第 2 步、第 3 步和第 4 步等结构来组织，详细指导您完成整个过程。  

● 过程归档 - WinCC 用户归档 

● 消息归档 - CSV/TXT 

● WinCC 用户归档 - OPC Data Access 
 

 
说明 

重要信息  
如果不希望执行上述章节中给出的步骤，而是直接在 WinCC Runtime 
中查看示例，则强烈建议您执行“在 WinCC Runtime 中查看示例 1 
(页 115)”一章中所述的步骤。 
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5.2.2 过程归档 - WinCC 用户归档 

5.2.2.1 第 1 步： 创建项目和链接 

简介 

本章介绍在 IDB 组态系统应用程序中创建项目和链接的完整步骤。 
操作目标是创建一个项目，并使相应链接以 WinCC OLEDB（过程归档）作为提供方并以 
WinCC 用户归档作为消费方。 

步骤 

 

1. 打开 IDB 组态并通过下述步骤创建项目： 

 

 

– 在 IDB 组态菜单中，选择“项目 > 创建”(Project > Create) 来创建一个新项目。 

– 在“创建新项目”(Create new project) 对话框中，指定一个项目名称，单击 [...] 
按钮并选择项目保存的目标文件夹位置。 

– 在输入所需信息后，选择“创建”(Create) 按钮。 这样就创建了一个新项目。 

2. 项目名称将列在“项目树”中。 
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3. 下一步是创建一个链接。 按照下述步骤创建一个提供方与消费方间的链接： 

 

 

– 在树结构中右键单击项目名称节点并选择“添加新链接”(Add new link) 选项。 

创建项目之后，默认情况下项目树形结构中项目名称节点下会显示一个新节点“添加

新链接”(Add new link)。  

您也可以通过双击项目树形结构中的“添加新链接”(Add new link) 
节点来创建新的链接。 

– 在显示的“添加新链接”(Add new link) 对话框中，输入唯一的链接名称。 

– 将提供方类型选为“WinCC OLEDB”，将目标类型选为“WinCC 用户归档”(WinCC 
User Archive)，然后单击“确定”(OK) 按钮。 

– 创建的链接将显示在项目树中项目名称下方。 

4. 创建相应的条目“提供方”(Provider)、“消费方”(Consumer)、“设置”(Settings) 
和“连接”(Connections)，并将它们作为树结构中新链接下方的节点。 

 

结果 

已创建一个项目，其中包含以 WinCC OLEDB 作为提供方并以 WinCC 
用户归档作为消费方的链接。 
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5.2.2.2 第 2 步： 组态接口 

简介 

您将在本章完成提供方/消费方组态以及传送行为设置。 
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步骤 

1. 在项目树中，双击“提供方”(Provider) 节点，打开“提供方组态”(Provider configuration) 
窗口。 

 

 

 

在“提供方组态”(Provider configuration) 窗口中，单击 [...] 按钮并选择从 WinCC 
导出的 WinCC 项目 XML 文件。 

 
 

  
说明 

WinCC 项目 XML 导出文件  
选择 WinCC 项目 XML 导出文件时，请记得要选择适当的 WinCC 项目 XML 文件。 
从安装 WinCC 的计算机导出 XML 文件。 在 WinCC 
项目管理器中，选择“IndustrialDataBridge > 项目 XML 导出”(IndustrialDataBridge > 
Project XML Export) 选项导出 XML 文件。 

 

要在 WinCC 站上使用 IDB CS，切勿选中“使用单点系统访问”(Use Single point of 
system access) 选项。 

– 在“归档组态”(Archive configuration) 部分，选择所选提供方的 WinCC 站名称。 
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说明 

WinCC 站 

• WinCC 站名称列在“WinCC 站名称”(WinCC station name) 
字段的下拉列表框中，其中显示 WinCC XML 文件所在的站名称。 从列表中选择 
WinCC 站名称。 

• 根据在“WinCC 项目 XML 文件”(WinCC project XML file) 文本框中选择的 WinCC 
项目 XML 文件，项目名称将自动显示。 

 
 

2. 接下来，在项目树中双击“消费方”(Consumer) 节点打开消费方组态窗口。 

 

 

 
 

  
说明 

连接字符串 
在“消费方组态”(Consumer configuration) 
窗口中，选择数据库类型后，“连接字符串”(Connection string) 
字段（位于顶部）可显示数据库连接字符串参数。 
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在“消费方组态”(Consumer configuration) 窗口中，执行以下设置： 

– 输入服务器名称和/或完整的 WinCC 用户归档数据库路径。 

– 从“数据库”(Database) 字段中显示的列表中，选择数据库名称。 
单击下拉列表框来查看此列表。 

– 要想使 Windows 自动进行验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic windows authentication)。 

– 在数据库登录选项所在的部分区域中，输入用户名和密码。 

此信息是登录 WinCC 用户归档数据库时所需的信息。 

– 单击“测试”(Test) 按钮测试连接。 
它测试用户归档数据库连接字符串并验证所选用户归档数据库。 
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执行链接设置 

1. 在项目树中，在工作区域中双击“设置”(Settings) 节点打开“设置”(Settings) 窗口。 
“设置”(Settings) 窗口由 3 个选项卡组成 -“传送选项”(Transfer 
options)、“连接映射”(Connection mapping) 和“连接”(Connections)。 

 

 

2. 在“传送选项”(Transfer options) 
选项卡中，可组态提供方的归档设置和传送行为设置。 

3. 在“归档设置”(Archive Settings) 部分中，选择归档类型。 在“归档”(Archive) 
字段，选择要传送“过程值归档”的数据还是“报警消息归档”的数据。 

根据所选的归档类型，“过程值”(Process value) 按钮和“事件”(Events) 
按钮将显示为禁用或启用状态。 

4. 单击“过程值”(Process value) 按钮打开“变量过滤器”(Variable Filter) 窗口。 
单击“事件”(Events) 按钮可打开“事件过滤器”(Events filter) 窗口。 

有关组态这些过滤器设置的更多信息，请参见“传送行为的组态 (页 38)”。  
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5. 在“消费方的时区”(Time zone for consumer) 字段中选择适当的时区。 

 

6. 在“时间设置”(Time Settings) 
部分，输入周期时间并从下拉列表框中选择单位（毫秒/秒/分/时）。 

7. 下一步，选择数据传送的类型： 

– 周期性与连续性 (Cyclic & Continuously) 

对此，传送时间通过计时器设置。 例如，这样就可启动持续多个小时的传送。  

该时间段由最后两个定时器时间定义。 

– 触发性与连续性 (Triggered & Continuously) 

对于此类型，传送时间由基于 OPC 变量的触发条件定义。 
该时间段由最后两个触发器时间定义。 IDB 
会标记上一次传送时间，并会读取两次触发器时间之间的间隔。 

–  触发的时间范围 (Triggered time span) 

对于此类型，传送时间由基于 OPC 变量的触发条件定义。 从 WinCC 
归档中读取的时间段另由两个其它的 OPC 变量定义。 

 
 

  
说明 

传送类型 
根据传送类型，按钮“时间范围”(Time span)、“启动行为”(Start-up behavior) 
和“触发器”(Trigger) 将处于启用或禁用状态。 

• 如果选择了选项“周期性与连续性”(Cyclic & Continuously) 
或“触发性与连续性”(Triggered & Continuously)，则“启动行为”(Start-up behavior) 
和“触发器”(Trigger) 按钮将都可用。 

• 选择“触发的时间范围”(Triggered time span) 选项，则只有“时间范围”(Timespan) 
和“触发器”(Trigger) 按钮可用。 
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8. 单击相应按钮打开对话框窗口，从中组态“触发器”(Trigger) 和“时间范围”(Time span) 
或“启动行为”(Start-up behavior)。 

有关传送设置功能及其选项的更多信息，请参见章节“第 3 步：传送行为的组态 
(页 38)”。 

9. 对于作为提供方的 WinCC OLEDB，其传送行为设置将自动保存。 

 
 

  
说明 

保存更改 
并不是每次在工作区的编辑器窗口内做出更改时都需要进行保存操作。 
对这些设置所做的更改是自动保存的。 但在项目创建后，您可随时通过选择“项目 > 
保存”(Project > Save) 菜单选项来保存项目。 

 

结果 

已将 WinCC OLEDB 接口和 WinCC 用户归档组态为消费方。 
这些元素会显示在组态界面的树结构中。 
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5.2.2.3 第 3 步： 传送行为的组态 

简介 

本章重点介绍与 WinCC OLEDB 传送设置功能及其选项相关的重要信息。  

组态选项 

“设置”(Settings) 
窗口提供下拉列表框、按钮或单选按钮形式的用户界面控件，可用于执行“归档类型设置”(
Archive type settings) 和“传送类型设置”(Transfer type settings)。 
下面说明这些对话框窗口中存在的组态设置及其选项。  

 

归档类型设置 

作为提供方的 WinCC OLEDB 支持两种归档类型。 
根据所选归档类型（“过程值归档”(Process value archive)、“报警消息归档”(Alarm 
message archive)），“过程值”(Process value) 按钮或“事件”(Events) 按钮将被激活。  

 

● 过程值归档变量 

● 报警消息归档变量 

 

过程值归档变量 

单击“过程值”(Process value) 按钮打开“变量过滤器”(Variable filter) 
窗口，该窗口中提供相应的选项，可组态或限制所要传送哪些过程值归档变量的值。 
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1. 在“归档”(Archive) 字段中，通过下拉列表选择要传送哪个归档的数据。 

2. “归档变量”(Archive variable) 部分显示归档变量列表。 
从窗口左侧显示的列表中选择一个或多个变量。 

3. 使用“>”将这些变量传送到右侧的选择区域，或使用“>>”来传送列表中的所有变量。 

使用“<”或“<<”从右侧的选择区域中删除所选变量或全部变量。 

4. 单击“确定”(OK) 按钮确认所做选择。 

 

报警消息归档变量 

单击“事件”(Events) 按钮打开“事件过滤器”(Events filter) 
窗口，借助该窗口内的选项可组态触发事件的各个报警消息编号。 
对于单独消息编号的值或要传送的消息编号范围，可以在“事件过滤器”(Events filter) 
对话框窗口中选择。 
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1. 在“单一事件”(Single Event) 字段文本框中输入一个消息编号，并单击“包括”(Include) 
按钮。 此消息将添加到“已选事件”(Chosen events) 列表中。 

2. 要指定消息编号范围，在“从”(From) 和“到”(To) 文本框中输入起始范围和结束范围。 
然后，单击“包括”(Include) 按钮添加到事件服务。 

3. 要从列表中排除任何事件，在列表中选择该事件并单击“排除”(Exclude) 按钮。 
要清除“已选事件”(Chosen events) 字段中的所有事件，单击“删除列表”(Delete list) 
按钮。 

4. 可从“归档语言”(Archive language) 字段的下拉列表框中选择归档语言。 
从而将按所选语言显示归档消息。 

5. 更改后，单击“确定”(OK) 按钮确认所做选择。 

 

传送类型设置 

WinCC OLEDB 支持三种传送类型设置，可以通过单击相应的单选钮选择。 
“时间范围”(Time span) 或“启动行为”(Start-up behavior) 或“触发器”(Trigger) 
按钮根据在“时间设置”(Time settings) 区域内所选的单选按钮选项激活。 
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单击相应的按钮将打开对应的对话框窗口。 
下面将介绍这些对话框窗口中所包含的组态选项。 

● 时间范围 

● 启动行为 

● 触发器 

 

时间范围 

只有在单选按钮选项“触发的时间范围”(Triggered time span) 已选择后，“时间范围”(Time 
span) 按钮才会激活。 单击“时间范围”(Time span) 按钮打开“时间范围”(Time span) 
对话框窗口。 所选变量的传送时间段在此“时间范围”(Time span) 窗口中定义。 
所做选择通过 OPC 变量浏览器中 OPC 服务器的变量控制。 

在“时间范围”(Time span) 窗口的“定义更新周期”(Define update cycle) 
区域中，可通过两种方法定义时间段： 

● 通过起始时间和结束时间定义（进行“从”(From) 和“到”(To) 选择） 

● 通过起始时间和和时间段定义（进行“+/-”选择） 
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步骤 

要定义传送时间段，按以下步骤操作： 

1. 在 OPC 变量浏览器中选择定义起始时间的变量。 

2. 在“从”(From) 行中单击“应用”(Apply) 按钮确认所做选择。 
所选的变量将添加到“从”(From) 文本框中。 

3. 选择适当的单选钮，以确定要定义结束时间还是时间段。 

4. 在 OPC 变量浏览器中选择定义结束时间或时间段的变量。 
所选的变量将添加到“从”(From) 字段下面的文本框中。 

5. 单击“到”(To) 行或“+/-”的“应用”(Apply) 按钮确认所做选择。 

6. 执行完所需更改后单击“确定”(OK) 按钮。 
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说明 

变量类型 
定义时间段的变量必须为“VT_I4”类型，或者为可通过 OPC 
服务器转换为“VT_I4”类型的字符串。 
对于时间范围，前面的符号决定时间段在起始时间（从(From)）之前 (-) 还是之后 (+)。 

 

 
说明 

未定义时间段 
如果未在“从”(From) 和“到”(To) 或“+/-
”字段内选择任何传送时间段，则所有可用数据都将传送。 

 

 

提供方类型与消费方类型的数字格式不同 

如果操作系统的日期格式不同于要转换的字符串所对应的日期格式，则必须调整 XML 
组态文件。 否则，可能出现转换错误。 

示例： 德语操作系统/“日期”字符串保存为英文格式。  

这种情况下，必须将 XML 组态文件中的条目 <Link UID="Ref-1" Name="Linkname"> 
修改为 <Link UID="Ref-1" Name="Linkname" LCID="1033">。  

属性 LCID (LocalID) 指示了字符串内容的目标保存格式。 
在转换期间，该字符串将转换为操作系统的格式。 语言名称及其 LCID 属性值如下所示：  

● 英语；LCID="1033" 

● 德语；LCID="1031" 

● 法语；LCID="1036" 

● 意大利语；LCID="1040" 

● 西班牙语；LCID="1034" 

● 中文；LCID="2052" 

● 日语；LCID="1041" 

有关其它可用的 LCID 值，请访问 http://www.microsoft.com 并输入搜索词“LCID”。 
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OPC 变量数据的时区  

通过从下拉列表框中选择时区来定义所选 OPC 变量数据的时区。 “OPC 
变量数据的时区”(Time zone for data of OPC variables) 字段位于 OPC 
变量浏览器的底部，其中包括一个可选择时区的下拉列表框。 
时区的默认设置是执行组态的计算机的本地时间。 如果 OPC 
服务器在另一个时区，请选择相应的时区。 执行完所需的更改后，单击“确定”(OK) 
按钮。 

 

启动行为 

如果选择了“周期性和连续性”或“触发性和连续性”传送类型中的任意一个，“启动行为”(Sta
rt-up behavior) 按钮将激活。 单击“启动行为”(Start-up behavior) 
按钮，打开“启动行为”(Start-up behavior) 对话框窗口。 此处涉及的设置将在 
IndustrialDataBridge Runtime 的启动过程中使用。 
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步骤 

要组态首次传送的行为，执行以下步骤： 

1. 在“首次传送的行为”(Behavior of first transfer) 区域中，选择一个选项。 

2. 如果已选择“OPC 变量定义的时间点”(Point in time defined by OPC tag)，在 OPC 
变量浏览器中标记相应的变量并单击“应用”(Apply) 按钮。 

3. 所选变量将添加到“OPC 变量定义的时间点”(Point in time defined by OPC tag) 
文本框中。 

4. 在“OPC 变量数据的时区”(Time zone for data of OPC tag) 下拉列表字段中，选择对 
OPC 变量执行数据传送的时区。 

 

5. 执行完所需更改后单击“确定”(Ok) 按钮。 
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说明 

变量类型 
定义时间点的变量必须为“VT_DATE”类型，或为可通过 OPC 
服务器转换为“VT_DATE”类型的字符串。 

 

 
说明 

传送行为 
 

• 如果选择“传送当前归档值”(Transfer current archive values) 
选项，将从数据传送开始时即传送当前值（过程值或报警消息）。 

• 如果选择“OPC 变量定义的时间点”(Point in time defined by OPC tag) 
选项，数据传送将从 OPC 变量定义的日期开始（位于文本框中），到当前日期结束。 

 
 

 

中断连接的最大时间 

通过 IDB CS 应用程序进行数据传送时，其连续性可以保证，即使 IDB 
停止时也支持这一点。 IDB CS 
应用程序会保存上次传送的持续时间，即使在重新启动后，也可继续完成传送而且不会丢

失数据。 此功能可以通过输入“中断连接的最大时间”(Maximum time for interrupted 
connection)（单位：分钟）加以限制。  

该值限制启动或连接中断后数据传送的时间段。 
如果值太小，会限制数据传送的连续性。 
输入中断连接的最大时间（单位：分钟）并单击“确定”(OK) 按钮。 

 

 
说明 

新的或已更改的组态文件 
只有在 IDB 运行系统环境中没有装载新组态文件或更改过的组态文件时才支持此功能。 
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OPC 变量数据的时区 

必须为所选 OPC 变量定义数据的时区。 通过从下拉列表框中选择时区来定义所选 OPC 
变量数据的时区。 “OPC 变量数据的时区”(Time zone for data of OPC variables) 
字段位于 OPC 变量浏览器的底部，其中包括一个可选择时区的下拉列表框。 
时区的默认设置是执行组态的计算机的本地时间。 如果 OPC 
服务器在另一个时区，请选择相应的时区。 

 

 
说明 

UTC 时间格式 
由于数据将以 UTC 时间格式存储在数据库中，强烈建议遵守 UTC 
时间格式或将时区设置为 UTC 时间格式。 

 

 

触发器 

在“触发器提供方”(Trigger Provider) 对话窗口中为此链接的数据传送组态触发条件。 
有关该对话窗口的详细介绍，请参见章节“组态触发器”。 

 

参见 

第 4 步：组态触发器 (页 48) 
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5.2.2.4 第 4 步：组态触发器 

简介 

“触发器提供方”(Trigger Provider) 对话框窗口提供 OPC 
设置、触发器组态选项以及组态数据传送触发条件所需的字段。 在“传送选项”(Transfer 
options) 窗口中单击“触发器”(Trigger) 按钮后，将打开此对话框窗口。 

步骤 

在“OPC 设置”(OPC settings) 区域，单击 [...] 按钮选择 OPC 服务器。 OPC 
变量浏览器支持选择服务器。 然后单击“勾号标记”按钮接受更改。  
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1. 该浏览器将显示本地 OPC 服务器。 也可在网络中搜索 OPC 服务器。 
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2. 如果服务器位于另一台计算机中，请输入该计算机的名称。 OPC 
服务器的树结构在“触发器组态”(Trigger Configuration) 区域显示。 

3. 您可以在触发器提供方上定义 OPC 
条目，数据传送的正常/故障状态将保存在“事务安全性对应变量”(Tag for Transaction 
Security) 字段中。 该值应为 1 字节有符号字符型（例如 VT_I1）。 -1 
代表正常状态，0 代表故障。 

4. 在变量浏览器中选择一个 OPC 服务器变量来保存此信息，并单击“应用项”(Apply item) 
按钮。 

5. 在“触发器组态”(Trigger Configuration) 区域中，选择所需变量并单击“添加项”(Add 
item) 予以接受（每个变量单击一次）。 

6. 使用“删除项”(Remove item) 按钮删除标记的项。 
如果没有任何项带有删除标记，则单击“删除项”(Remove item) 
按钮后，列表中最后一个条目将被删除。 
有关变量列表中各列的详细信息，请参见“变量声明”部分。 

 
  

说明 

OPC 服务器 
选择变量并将其添加到变量列表后，如果在“OPC 设置”(OPC Settings) 
区域内切换到另一台 OPC 服务器，将显示一个对话窗口提示您是否要放弃先前设置。 

 

7. 在“触发条件”(Trigger condition) 区域中，可以单击按钮“VB 风格”(Style) 或“JScript 
风格”(JScript Style) 按钮选择语法类型。 
如果已创建触发条件，则不能再更改此设置。 
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如果要更改语言，必须删除“组态触发条件”(Configure Trigger Condition) 
字段中的文本。 

有关编程语言的详细介绍，请参见“编程语言”部分。 

8. 用所选语言创建触发条件。 使用这些变量在变量列表中显示的别名标识。 
在显示的文本框中，使用键盘输入或从“逻辑模式”(Logical patterns) 
列表框中选择操作符。 

9. 单击“验证”(Validate) 测试已创建的条件。 触发条件将根据“测试值”(Test value) 
列输入的值进行计算。 结果“TRUE”或“FALSE”将显示在消息框中。 

10. 如果触发条件的结果正确无误，则在确认更改后，单击“确定”(OK) 
按钮关闭对话框。 

 

其它信息 

变量声明 

变量声明的列包括： 

● “数据类型”(Data type)： 变量的数据类型。 
如果此处定义的数据类型与服务器上的不匹配，则将尝试转换该数据类型。 

● “TagID”： OPC 服务器变量的 TagID。 

● “别名”(Alias)： 别名用于创建触发条件。 
此名称必须唯一，而且必须符合所分配编程语言的命名约定。 
有关命名约定的详细信息，请参见“有效别名”段落。 

● “确认值”(Confirmation value)： 
确认值是在满足触发条件后变量采用的值并且该值已传送到消费方。 
默认值为“<无>”(<Empty>)，即无任何确认值。 

● “测试值”(Test value)： 该值仅用于测试触发条件，对之后的数据交换没有任何影响。 
测试值的选择和更改应保证能够测出，触发条件是否在所有运行条件下都可得到预期

结果。 
 

 
说明 

确认值 
该确认值并不会给出是否成功完成事务的信息。 
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说明 

别名的必要性 
不使用 OPC ItemID 
的原因是，它可能不符合变量的有效性标准，例如，变量名中不允许使用“句点”。 

 

 

有效别名： 

有效的别名必须符合以下规则： 

● 字母（没有带变音符的字符或 ß）、数字和下划线 (_) 均允许使用。 

● 第一个字符必须是字母或下划线。 

● 别名的长度不限。 

● 不允许使用 VB 脚本或 J 脚本中的关键字。 请注意各语言对此的描述。 

● 区分大小写。 
（“tag”与“Tag”不同）。 

 

编程语言  

触发条件可以使用 VBScript 或 JScript。 

下表显示了两种语言的操作符类型及其符号： 

 

 

类型 VBScript JScript 

逻辑 NOT（非） NOT ! 

逻辑 AND（与） AND && 

逻辑 OR（或） OR || 

乘 * * 

除 / / 

加 + + 

减 - - 

不等于 <> != 
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类型 VBScript JScript 

小于 < < 

大于 > > 

比较 = == 

赋值 <不支持> = 

True true 或 True true 

错误 false 或 False false 

字符串 <引号> <引号> 

建议只使用这些操作符。 有关其它操作符，请参见相应语言的语言介绍。 
 

 
说明 

触发事件丢失 
触发取决于 OPC 服务器的更新速度。 
在此情况下需注意的是，触发器识别不到更新周期内发生的数据变化。 
这意味着，对于变量较快地从 1 变到 0 再变回 1 的情况，OPC 
服务器将不会通知触发器提供方，因为在检查时变量仍为 1 并且不存在值的变化。 
也就是说，潜在的真条件并不一定会被识别为真，因而不会引起数据传送。 
 
由于上述原因，如果在相应的组态中确认值设置为“真”触发条件到“假”触发条件的循环，

并不能保证达到预期结果。 
如果数据变化过快，“真值”可能会保持不变，从而相应的值会被遗漏。 
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5.2.2.5 第 5 步： 连接变量 

简介 

本章介绍在提供方与消费方之间执行连接映射所需的步骤。 

连接变量 

在“设置”(Settings) 窗口中，“连接映射”(Connection mapping) 
选项卡包含相应的字段，可为所选数据消费方连接 WinCC OLEDB 接口已发送的变量。 
“连接映射”(Connection mapping) 选项卡将窗口分为 3 个部分。  

● WinCC OLEDB 提供方 

● WinCC 用户归档消费方 

● 连接映射属性 

 

“WinCC OLEDB 提供方”(WinCC OLEDB provider) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的左上部。 此部分提供相应选项，借此可从“列”(Columns) 
部分区域中显示的各列的列表中选择列名称。 “WinCC 用户归档消费方”(WinCC User 
Archive consumer) 部分位于提供方部分下方，所含选项可用于选择与 WinCC OLEDB 
接口中现有列进行映射的方案、表格名称和列名称。  

在 WinCC OLEDB 提供方列以及在“Where 语句”(Where statement) 
选项卡中选择的列（属于 WinCC 用户归档消费方）之间创建一个特定的连接。 
您可创建一个新连接或修改现有连接，以便将“Where 语句”(Where statement) 
应用于所选列。 

 

提供方部分与消费方部分之间的分隔符提供了一个大小调整控点，可借以调整该部分的高

度，从而可清楚地查看此部分中的字段。  

 

“连接映射设置”(Connection mapping settings) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的右侧。 
在此部分中可提供连接名称，同时也提供了选择连接默认名称的选项。 
“连接”(Connect)、“修改连接”(Modify connection)、“删除连接”(Delete connection) 
和“删除所有连接”(Delete all connections) 图标都位于此部分的上部。 
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1. 在“WinCC OLEDB 提供方”(WinCC OLEDB provider) 部分，从“列”(Columns) 
区域显示的列表中选择列名称。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 字段中。 
数据类型将根据所选列名称自动选择。 

3. 借助“过滤器”(Filter) 
字段，您可根据列名称的一个字符或前面几个字符来对列名称进行过滤。 

例如，如果要查看以“S”开头的列名称，在“过滤器”(Filter) 文本框中输入该字符。 
所有以“S”开头的列名称都将显示出来。  

4. 接下来，按以下步骤在“WinCC 用户归档消费方”(WinCC User Archive consumer) 
选项卡中组态消费方列： 

– 所选的表格显示在“表格”(Table) 字段中。 通过“方案”(Schema) 
字段中的下拉列表为数据库选择方案（如果适用）。 

– 列名称在“列”(Columns) 区域中显示。 
如果表格中有各个数据类型的列，也可将时间戳写入表格。 
这种情况下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for 
timestamp) 字段中选择该列。 
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5. 选择要与“WinCC OLEDB 提供方”(WinCC OLEDB provider) 连接的列名称。 
所选的列显示在“数据值列”(Column for data value) 字段中。 

6. 在右侧的“连接映射设置”(Connection mapping settings) 区域检查连接名称。 
在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

 
 

  
说明 

数据类型转换 
如果提供方列与消费方列不匹配，IDB CS 
将转换数据类型，使其与提供方的数据类型相匹配。随即将显示出一个状态窗口指示

此项更改。 
 

7. 对“WinCC OLEDB 提供方”(WinCC OLEDB provider) 所有要传送的元素，重复第 1 
到第 6 步。 

 

“Where 语句”(Where-Statement) 选项卡 

为了在 WinCC 用户归档消费方中选择列，需对 Where 语句进行组态。 “Where 
语句”(Where-statement) 选项卡主要包括“Where 语句”组态部分和异常处理部分。 

 

如需执行连接映射，执行以下步骤： 

1. 在“WinCC OLEDB 提供方”(WinCC OLEDB provider) 部分（左上方），选择要应用 
Where 语句的列（WinCC 用户归档消费方）。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 
字段中。数据类型将根据所选列名称自动选择。 

3. 在“Where 列”(Where-column) 字段，选择要用于 Where 语句的列。 
如果要向数据库中写入一个值，则会比较此列与连接的提供方列。 
只更新两个值匹配的行。 
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4. 如果在消费方一行中所做选择不唯一，则在“异常行为”(Exceptional behaviour) 
部分中定义行为： 

– 错误消息： 不覆盖任何消费方行，发出一条错误消息作为 IDB Runtime 
跟踪视图中的输出。 

– 更改所有行： 覆盖所有已选中的消费方行。 

– 如果不存在带有键（主键）的行，则使用“启用插入”(Enable Insert) 
复选框定义行为。 如果选择此选项，则创建一个带有相应键的新行。 

 
  

说明 

同时用作键列和消费方列 
为了通过组态获得更多的设置功能，可将一个列同时用作键列和消费方列。 
请注意，这将引起数据库中的数据不一致和/或对 WinCC 
用户归档消费方的后续访问可能导致出错。 

 

5. 在“连接映射设置”(Connection mapping settings) 
区域（右侧）中检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

“删除设置”(Delete settings) 选项卡 

使用“WinCC 用户归档消费方”(WinCC User Archive 
consumer)，可删除来自用户归档的数据记录。 这需要将提供方列连接到消费方列。 
如果满足删除条件，就会从用户归档中删除消费方列的数据记录。 “删除”(Delete) 
的优先级高于“插入”(Insert) 和“更新”(Update) 操作。 

 

如需执行连接映射，执行以下步骤： 

1. 在“WinCC OLEDB 提供方”(WinCC OLEDB provider) 
部分（左上方），选择应进行值比较操作的列。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 
字段中。数据类型将根据所选列名称自动选择。 
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3. 在“删除设置”(Delete settings) 选项卡中，启用“可删除”(Delete possible) 
复选框并在“删除变量的值”(Value for delete variable) 字段内输入删除列的值。 

如果连接提供方列采用此值，则会根据 Where 
语句从用户归档中删除包含此值的相应数据记录。 

4. 在连接区域（右侧）检查连接名称。 在“连接”(Connection) 
字段中输入连接的唯一名称或使用默认名称惯例。单击“连接”(Connect) 
按钮确认输入内容。 

 

结果 

已创建的连接显示在 IDB CS“设置”(Settings) 窗口的“连接”(Connections) 
选项卡和项目树节点中。 
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5.2.3 消息归档 - CSV/TXT 

5.2.3.1 第 1 步：创建项目和链接 

简介 

本章介绍在 IDB 组态系统应用程序中创建项目和链接的完整步骤。 
操作目标是创建一个项目，并使相应链接以 WinCC OLEDB（消息归档）作为提供方并以 
CSV/TXT 作为消费方。 

步骤 

 

1. 打开 IDB 组态并通过下述步骤创建项目： 

 

 

– 在 IDB 组态菜单中，选择“项目 > 创建”(Project > Create) 来创建一个新项目。 

– 在“创建新项目”(Create new project) 对话框中，指定一个项目名称，单击 [...] 
按钮并选择项目保存的目标文件夹位置。 

– 在输入所需信息后，选择“创建”(Create) 按钮。这样就创建了一个新项目。 

2. 项目名称将列在“项目树”中。 
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3. 下一步是创建一个链接。 按照下述步骤创建一个提供方与消费方间的链接： 

 

 

– 在树结构中右键单击项目名称节点并选择“添加新链接”(Add new link) 选项。 

创建项目之后，默认情况下项目树形结构中项目名称节点下会显示一个新节点“添加

新链接”(Add new link)。  

您也可以通过双击项目树形结构中的“添加新链接”(Add new link) 
节点来创建新的链接。 

– 在显示的“添加新链接”(Add new link) 对话框中，输入唯一的链接名称。 

– 将提供方类型选为“WinCC 
OLEDB”，将目标类型选为“CSV/TXT”，然后单击“确定”(OK) 按钮。 

– 创建的链接将显示在项目树中项目名称下方。 

4. 创建相应的条目“提供方”(Provider)、“消费方”(Consumer)、“设置”(Settings) 
和“连接”(Connections)，并将它们作为树结构中新链接下方的节点。 

 

结果 

已创建一个项目，其中包含以 WinCC OLEDB 作为提供方并以 CSV/TXT 
作为消费方的链接。 
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5.2.3.2 第 2 步： 组态接口 

简介 

您将在本章完成提供方/消费方组态以及提供方的传送行为设置。 
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步骤 

1. 在项目树中，双击“提供方”(Provider) 节点，打开“提供方组态”(Provider configuration) 
窗口。 

 

 

在“提供方组态”(Provider configuration) 窗口中，单击 [...] 按钮并选择从 WinCC 
导出的 WinCC 项目 XML 文件。 

 
 

  
说明 

WinCC 项目 XML 导出文件 
选择 WinCC 项目 XML 导出文件时，请记得要选择适当的 WinCC 项目 XML 文件。 
从安装 WinCC 的计算机导出 XML 文件。 在 WinCC 
项目管理器中，选择“IndustrialDataBridge > 项目 XML 导出”(IndustrialDataBridge > 
Project XML Export) 选项导出 XML 文件。 

 

2. 要在 WinCC 站上使用 IDB CS，切勿选中“使用单点系统访问”(Use Single point of 
system access) 选项。 

– 在“归档组态”(Archive configuration) 部分，选择所选提供方的 WinCC 站名称。 
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说明 

WinCC 站 
 

• WinCC 站名称列在“WinCC 站名称”(WinCC station name) 
字段的下拉列表框中，其中显示 WinCC XML 文件所在的站名称。 从列表中选择 
WinCC 站名称。 

• 根据在“WinCC 项目 XML 文件”(WinCC project XML file) 文本框中选择的 WinCC 
项目 XML 文件，项目名称将自动显示。 

 

3. 接下来，在项目树中双击“消费方”(Consumer) 节点打开消费方组态窗口。 

 

 

– 在“CSV/TXT 组态”(CSV/TXT Configuration) 字段单击 [...] 
按钮，然后通过浏览文件夹结构选择相应文件夹。 

– 单击“测试”(Test) 按钮测试连接。 “连接字符串”(Connection string) 
将显示在此窗口顶部所示“连接字符串”(Connection string) 文本框中。 
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执行链接设置 

 

1. 在项目树中，在工作区域中双击“设置”(Settings) 节点打开“设置”(Settings) 
窗口。“设置”(Settings) 窗口由 3 个选项卡组成 -“传送选项”(Transfer 
options)、“连接映射”(Connection mapping) 和“连接”(Connections)。 

 

 

2. 在“传送选项”(Transfer options) 
选项卡中，可组态提供方的归档设置和传送行为设置。 

3. 在“归档设置”(Archive Settings) 部分中，选择归档类型。在“归档”(Archive) 
字段，选择要传送“过程值归档”的数据还是“报警消息归档”的数据。 

根据所选的归档类型，“过程值”(Process value) 按钮和“事件”(Events) 
按钮将显示为禁用或启用状态。 

4. 单击“过程值”(Process value) 按钮打开“变量过滤器”(Variable Filter) 
窗口。单击“事件”(Events) 按钮可打开“事件过滤器”(Events filter) 窗口。 
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5. 在“消费方的时区”(Time zone for consumer) 字段中选择适当的时区。 

6. 在“时间设置”(Time Settings) 
部分，输入周期时间并从下拉列表框中选择单位（毫秒/秒/分/时）。 

7. 下一步，选择数据传送的类型： 

– 周期性与连续性 (Cyclic & Continuously) 

对此，传送时间通过计时器设置。例如，这样就可启动持续多个小时的传送。 

该时间段由最后两个定时器时间定义。 

– 触发性与连续性 (Triggered & Continuously) 

对于此类型，传送时间由基于 OPC 
变量的触发条件定义。该时间段由最后两个触发器时间定义。IDB 
会标记上一次传送时间，并会读取两次触发器时间之间的间隔。 

–  触发的时间范围 (Triggered time span) 

对于此类型，传送时间由基于 OPC 变量的触发条件定义。 从 WinCC 
归档中读取的时间段另由两个其它的 OPC 变量定义。 

 
  

说明 

传送类型 
根据传送类型，按钮“时间范围”(Time span)、“启动行为”(Start-up behavior) 
和“触发器”(Trigger) 将处于启用或禁用状态。 

• 如果选择了选项“周期性与连续性”(Cyclic & Continuously) 
或“触发性与连续性”(Triggered & Continuously)，则“启动行为”(Start-up behavior) 
和“触发器”(Trigger) 按钮将都可用。 

• 选择“触发的时间范围”(Triggered time span) 选项，则只有“时间范围”(Timespan) 
和“触发器”(Trigger) 按钮可用。 
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8. 单击相应按钮打开对话框窗口，从中组态“触发器”(Trigger) 和“时间范围”(Time span) 
或“启动行为”(Start-up behavior)。 

有关传送设置功能及其选项的更多信息，请参见章节“第 3 步：传送行为的组态 
(页 67)”。 

9. 对于作为提供方的 WinCC OLEDB，其传送行为设置将自动保存。 

 
  

说明 

保存更改 
并不是每次在工作区的编辑器窗口内做出更改时都需要进行保存操作。对这些设置所

做的更改是自动保存的。 但在项目创建后，您可随时通过选择“项目 > 保存”(Project > 
Save) 菜单选项来保存项目。 

 

 

结果 

已组态 WinCC OLEDB 接口和 CSV/TXT 
作为消费方。这些元素会显示在组态界面的树结构中。 

参见 

第 3 步： 传送行为的组态 (页 38) 
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5.2.3.3 第 3 步： 传送行为的组态 

简介 

本章重点介绍与 WinCC OLEDB 传送设置功能及其选项相关的重要信息。  

组态选项 

“设置”(Settings) 
窗口提供下拉列表框、按钮或单选按钮形式的用户界面控件，可用于执行“归档类型设置”(
Archive type settings) 和“传送类型设置”(Transfer type settings)。 
下面说明这些对话框窗口中存在的组态设置及其选项。  

 

归档类型设置 

作为提供方的 WinCC OLEDB 支持两种归档类型。 
根据所选归档类型（“过程值归档”(Process value archive)、“报警消息归档”(Alarm 
message archive)），“过程值”(Process value) 按钮或“事件”(Events) 按钮将被激活。  

 

● 过程值归档变量 

● 报警消息归档变量 

 

过程值归档变量 

单击“过程值”(Process value) 按钮打开“变量过滤器”(Variable filter) 
窗口，该窗口中提供相应的选项，可组态或限制所要传送哪些过程值归档变量的值。 
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1. 在“归档”(Archive) 字段中，通过下拉列表选择要传送哪个归档的数据。 

2. “归档变量”(Archive variable) 部分显示归档变量列表。 
从窗口左侧显示的列表中选择一个或多个变量。 

3. 使用“>”将这些变量传送到右侧的选择区域，或使用“>>”来传送列表中的所有变量。 

使用“<”或“<<”从右侧的选择区域中删除所选变量或全部变量。 

4. 单击“确定”(OK) 按钮确认所做选择。 

 

报警消息归档变量 

单击“事件”(Events) 按钮打开“事件过滤器”(Events filter) 
窗口，借助该窗口内的选项可组态触发事件的各个报警消息编号。 
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对于单独消息编号的值或要传送的消息编号范围，可以在“事件过滤器”(Events filter) 
对话框窗口中选择。 

 

 

1. 在“单一事件”(Single Event) 字段文本框中输入一个消息编号，并单击“包括”(Include) 
按钮。 此消息将添加到“已选事件”(Chosen events) 列表中。 

2. 要指定消息编号范围，在“从”(From) 和“到”(To) 文本框中输入起始范围和结束范围。 
然后，单击“包括”(Include) 按钮添加到事件服务。 

3. 要从列表中排除任何事件，在列表中选择该事件并单击“排除”(Exclude) 按钮。 
要清除“已选事件”(Chosen events) 字段中的所有事件，单击“删除列表”(Delete list) 
按钮。 

4. 可从“归档语言”(Archive language) 字段的下拉列表框中选择归档语言。 
从而将按所选语言显示归档消息。 

5. 更改后，单击“确定”(OK) 按钮确认所做选择。 
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传送类型设置 

WinCC OLEDB 支持三种传送类型设置，可以通过单击相应的单选钮选择。 
“时间范围”(Time span) 或“启动行为”(Start-up behavior) 或“触发器”(Trigger) 
按钮根据在“时间设置”(Time settings) 区域内所选的单选按钮选项激活。 
单击相应的按钮将打开对应的对话框窗口。 
下面将介绍这些对话框窗口中所包含的组态选项。 

● 时间范围 

● 启动行为 

● 触发器 

 

时间范围 

只有在单选按钮选项“触发的时间范围”(Triggered time span) 已选择后，“时间范围”(Time 
span) 按钮才会激活。 单击“时间范围”(Time span) 按钮打开“时间范围”(Time span) 
对话框窗口。 所选变量的传送时间段在此“时间范围”(Time span) 窗口中定义。 
所做选择通过 OPC 变量浏览器中 OPC 服务器的变量控制。 

在“时间范围”(Time span) 窗口的“定义更新周期”(Define update cycle) 
区域中，可通过两种方法定义时间段： 

● 通过起始时间和结束时间定义（进行“从”(From) 和“到”(To) 选择） 

● 通过起始时间和和时间段定义（进行“+/-”选择） 
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步骤 

要定义传送时间段，按以下步骤操作： 

1. 在 OPC 变量浏览器中选择定义起始时间的变量。 

2. 在“从”(From) 行中单击“应用”(Apply) 按钮确认所做选择。 
所选的变量将添加到“从”(From) 文本框中。 

3. 选择适当的单选钮，以确定要定义结束时间还是时间段。 

4. 在 OPC 变量浏览器中选择定义结束时间或时间段的变量。 
所选的变量将添加到“从”(From) 字段下面的文本框中。 

5. 单击“到”(To) 行或“+/-”的“应用”(Apply) 按钮确认所做选择。 

6. 执行完所需更改后单击“确定”(OK) 按钮。 

 

 
说明 

变量类型 
定义时间段的变量必须为“VT_I4”类型，或者为可通过 OPC 
服务器转换为“VT_I4”类型的字符串。 
对于时间范围，前面的符号决定时间段在起始时间（从(From)）之前 (-) 还是之后 (+)。 
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说明 

未定义时间段 
如果未在“从”(From) 和“到”(To) 或“+/-
”字段内选择任何传送时间段，则所有可用数据都将传送。 

 

 

提供方类型与消费方类型的数字格式不同 

如果操作系统的日期格式不同于要转换的字符串所对应的日期格式，则必须调整 XML 
组态文件。 否则，可能出现转换错误。 

示例： 德语操作系统/“日期”字符串保存为英文格式。  

这种情况下，必须将 XML 组态文件中的条目 <Link UID="Ref-1" Name="Linkname"> 
修改为 <Link UID="Ref-1" Name="Linkname" LCID="1033">。  

属性 LCID (LocalID) 指示了字符串内容的目标保存格式。 
在转换期间，该字符串将转换为操作系统的格式。 语言名称及其 LCID 属性值如下所示：  

● 英语；LCID="1033" 

● 德语；LCID="1031" 

● 法语；LCID="1036" 

● 意大利语；LCID="1040" 

● 西班牙语；LCID="1034" 

● 中文；LCID="2052" 

● 日语；LCID="1041" 

有关其它可用的 LCID 值，请访问 http://www.microsoft.com (http://www.microsoft.com) 
并输入搜索词“LCID”。 

 

OPC 变量数据的时区  

通过从下拉列表框中选择时区来定义所选 OPC 变量数据的时区。 “OPC 
变量数据的时区”(Time zone for data of OPC variables) 字段位于 OPC 
变量浏览器的底部，其中包括一个可选择时区的下拉列表框。 
时区的默认设置是执行组态的计算机的本地时间。 如果 OPC 
服务器在另一个时区，请选择相应的时区。 执行完所需的更改后，单击“确定”(OK) 
按钮。 

http://www.microsoft.com/
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启动行为 

如果选择了“周期性和连续性”或“触发性和连续性”传送类型中的任意一个，“启动行为”(Sta
rt-up behavior) 按钮将激活。 单击“启动行为”(Start-up behavior) 
按钮，打开“启动行为”(Start-up behavior) 对话框窗口。 此处涉及的设置将在 
IndustrialDataBridge Runtime 的启动过程中使用。 

 

 

 

步骤 

要组态首次传送的行为，执行以下步骤： 

1. 在“首次传送的行为”(Behavior of first transfer) 区域中，选择一个选项。 

2. 如果已选择“OPC 变量定义的时间点”(Point in time defined by OPC tag)，在 OPC 
变量浏览器中标记相应的变量并单击“应用”(Apply) 按钮。 
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3. 所选变量将添加到“OPC 变量定义的时间点”(Point in time defined by OPC tag) 
文本框中。 

4. 在“OPC 变量数据的时区”(Time zone for data of OPC tag) 下拉列表字段中，选择对 
OPC 变量执行数据传送的时区。 

 

5. 执行完所需更改后单击“确定”(Ok) 按钮。 

 

 
说明 

变量类型 
定义时间点的变量必须为“VT_DATE”类型，或为可通过 OPC 
服务器转换为“VT_DATE”类型的字符串。 

 

 
说明 

传送行为 
 

• 如果选择“传送当前归档值”(Transfer current archive values) 
选项，将从数据传送开始时即传送当前值（过程值或报警消息）。 

• 如果选择“OPC 变量定义的时间点”(Point in time defined by OPC tag) 
选项，数据传送将从 OPC 变量定义的日期开始（位于文本框中），到当前日期结束。 

 
 

 

中断连接的最大时间 

通过 IDB CS 应用程序进行数据传送时，其连续性可以保证，即使 IDB 
停止时也支持这一点。 IDB CS 
应用程序会保存上次传送的持续时间，即使在重新启动后，也可继续完成传送而且不会丢

失数据。 此功能可以通过输入“中断连接的最大时间”(Maximum time for interrupted 
connection)（单位：分钟）加以限制。  
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该值限制启动或连接中断后数据传送的时间段。 
如果值太小，会限制数据传送的连续性。 
输入中断连接的最大时间（单位：分钟）并单击“确定”(OK) 按钮。 

 

 
说明 

新的或已更改的组态文件 
只有在 IDB 运行系统环境中没有装载新组态文件或更改过的组态文件时才支持此功能。 

 

 

OPC 变量数据的时区 

必须为所选 OPC 变量定义数据的时区。 通过从下拉列表框中选择时区来定义所选 OPC 
变量数据的时区。 “OPC 变量数据的时区”(Time zone for data of OPC variables) 
字段位于 OPC 变量浏览器的底部，其中包括一个可选择时区的下拉列表框。 
时区的默认设置是执行组态的计算机的本地时间。 如果 OPC 
服务器在另一个时区，请选择相应的时区。 

 

 
说明 

UTC 时间格式 
由于数据将以 UTC 时间格式存储在数据库中，强烈建议遵守 UTC 
时间格式或将时区设置为 UTC 时间格式。 

 

 

触发器 

在“触发器提供方”(Trigger Provider) 对话窗口中为此链接的数据传送组态触发条件。 
有关该对话窗口的详细介绍，请参见章节“组态触发器 (页 76)”。 
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5.2.3.4 第 4 步：组态触发器 

简介 

“触发器提供方”(Trigger Provider) 对话框窗口提供 OPC 
设置、触发器组态选项以及组态数据传送触发条件所需的字段。 在“传送选项”(Transfer 
options) 窗口中单击“触发器”(Trigger) 按钮后，将打开此对话框窗口。 

步骤 

在“OPC 设置”(OPC settings) 区域，单击 [...] 按钮选择 OPC 服务器。 OPC 
变量浏览器支持选择服务器。 然后单击“勾号标记”按钮接受更改。  
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1. 该浏览器将显示本地 OPC 服务器。 也可在网络中搜索 OPC 服务器。 
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2. 如果服务器位于另一台计算机中，请输入该计算机的名称。 OPC 
服务器的树结构在“触发器组态”(Trigger Configuration) 区域显示。 

3. 您可以在触发器提供方上定义 OPC 
条目，数据传送的正常/故障状态将保存在“事务安全性对应变量”(Tag for Transaction 
Security) 字段中。 该值应为 1 字节有符号字符型（例如 VT_I1）。 -1 
代表正常状态，0 代表故障。 

4. 在变量浏览器中选择一个 OPC 服务器变量来保存此信息，并单击“应用项”(Apply item) 
按钮。 

5. 在“触发器组态”(Trigger Configuration) 区域中，选择所需变量并单击“添加项”(Add 
item) 予以接受（每个变量单击一次）。 

6. 使用“删除项”(Remove item) 按钮删除标记的项。 
如果没有任何项带有删除标记，则单击“删除项”(Remove item) 
按钮后，列表中最后一个条目将被删除。 
有关变量列表中各列的详细信息，请参见“变量声明”部分。 

 
  

说明 

OPC 服务器 
选择变量并将其添加到变量列表后，如果在“OPC 设置”(OPC Settings) 
区域内切换到另一台 OPC 服务器，将显示一个对话窗口提示您是否要放弃先前设置。 

 

7. 在“触发条件”(Trigger condition) 区域中，可以单击按钮“VB 风格”(Style) 或“JScript 
风格”(JScript Style) 按钮选择语法类型。 
如果已创建触发条件，则不能再更改此设置。 
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如果要更改语言，必须删除“组态触发条件”(Configure Trigger Condition) 
字段中的文本。 

有关编程语言的详细介绍，请参见“编程语言”部分。 

8. 用所选语言创建触发条件。 使用这些变量在变量列表中显示的别名标识。 
在显示的文本框中，使用键盘输入或从“逻辑模式”(Logical patterns) 
列表框中选择操作符。 

9. 单击“验证”(Validate) 测试已创建的条件。 触发条件将根据“测试值”(Test value) 
列输入的值进行计算。 结果“TRUE”或“FALSE”将显示在消息框中。 

10. 如果触发条件的结果正确无误，则在确认更改后，单击“确定”(OK) 
按钮关闭对话框。 

 

其它信息 

变量声明 

变量声明的列包括： 

● “数据类型”(Data type)： 变量的数据类型。 
如果此处定义的数据类型与服务器上的不匹配，则将尝试转换该数据类型。 

● “TagID”： OPC 服务器变量的 TagID。 

● “别名”(Alias)： 别名用于创建触发条件。 
此名称必须唯一，而且必须符合所分配编程语言的命名约定。 
有关命名约定的详细信息，请参见“有效别名”段落。 

● “确认值”(Confirmation value)： 
确认值是在满足触发条件后变量采用的值并且该值已传送到消费方。 
默认值为“<无>”(<Empty>)，即无任何确认值。 

● “测试值”(Test value)： 该值仅用于测试触发条件，对之后的数据交换没有任何影响。 
测试值的选择和更改应保证能够测出，触发条件是否在所有运行条件下都可得到预期

结果。 
 

 
说明 

确认值 
该确认值并不会给出是否成功完成事务的信息。 
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说明 

别名的必要性 
不使用 OPC ItemID 
的原因是，它可能不符合变量的有效性标准，例如，变量名中不允许使用“句点”。 

 

 

有效别名： 

有效的别名必须符合以下规则： 

● 字母（没有带变音符的字符或 ß）、数字和下划线 (_) 均允许使用。 

● 第一个字符必须是字母或下划线。 

● 别名的长度不限。 

● 不允许使用 VB 脚本或 J 脚本中的关键字。 请注意各语言对此的描述。 

● 区分大小写。 
（“tag”与“Tag”不同）。 

 

编程语言  

触发条件可以使用 VBScript 或 JScript。 

下表显示了两种语言的操作符类型及其符号： 

 

 

类型 VBScript JScript 

逻辑 NOT（非） NOT ! 

逻辑 AND（与） AND && 

逻辑 OR（或） OR || 

乘 * * 

除 / / 

加 + + 

减 - - 

不等于 <> != 
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类型 VBScript JScript 

小于 < < 

大于 > > 

比较 = == 

赋值 <不支持> = 

True true 或 True true 

错误 false 或 False false 

字符串 <引号> <引号> 

建议只使用这些操作符。 有关其它操作符，请参见相应语言的语言介绍。 
 

 
说明 

触发事件丢失 
触发取决于 OPC 服务器的更新速度。 
在此情况下需注意的是，触发器识别不到更新周期内发生的数据变化。 
这意味着，对于变量较快地从 1 变到 0 再变回 1 的情况，OPC 
服务器将不会通知触发器提供方，因为在检查时变量仍为 1 并且不存在值的变化。 
也就是说，潜在的真条件并不一定会被识别为真，因而不会引起数据传送。 
 
由于上述原因，如果在相应的组态中确认值设置为“真”触发条件到“假”触发条件的循环，

并不能保证达到预期结果。 
如果数据变化过快，“真值”可能会保持不变，从而相应的值会被遗漏。 
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5.2.3.5 第 5 步： 连接变量 

简介 

本章介绍在提供方与消费方之间执行连接映射所需的步骤。 

连接变量 

在“设置”(Settings) 窗口中，“连接映射”(Connection mapping) 
选项卡包含相应的字段，可为所选数据消费方连接 WinCC OLEDB 接口已发送的变量。 
“连接映射”(Connection mapping) 选项卡将窗口分为 3 个部分。  

● WinCC OLEDB 提供方 

● CSV/TXT 消费方 

● 连接映射属性 

 

 

 



 入门指南和示例 
 5.2 入门指南示例 1 

WinCC/IndustrialDataBridge 入门指南 
入门指南, 5/2014 83 

WinCC OLEDB 提供方 

“WinCC OLEDB 提供方”(WinCC OLEDB provider) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的左上部。 此部分提供相应选项，借此可从“列”(Columns) 
部分区域中显示的各列的列表中选择列名称。  

提供方部分与消费方部分之间的分隔符提供了一个大小调整控点，可借以调整该部分的高

度，从而可清楚地查看此部分中的字段。  

“连接映射设置”(Connection mapping settings) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的右侧。 
在此部分中可提供连接名称，同时也提供了选择连接默认名称的选项。 
“连接”(Connect)、“修改连接”(Modify connection)、“删除连接”(Delete connection) 
和“删除所有连接”(Delete all connections) 图标都位于此部分的上部。 

 

CSV/TXT 消费方 

CSV/TXT 消费方显示在提供方部分下方，包括用于在 CSV/TXT 文件中选择列的选项。 
它还包括使用所需列创建新 CSV/TXT 文件的选项。  

在消费方部分，“最大条目数组态”(Maximum Entry Configuration) 
选项卡显示在“CSV/TXT 消费方”(CSV/TXT consumer) 选项卡旁边。 
“最大条目数组态”(Maximum entry configuration) 
选项卡提供了生成归档文件名称的字段。 

 

“CSV/TXT 消费方”(CSV/TXT consumer) 选项卡显示“CSV/TXT”和“列”(Columns) 区域。  

“CSV/TXT”区域包括选择 CSV/TXT 文件的选项。 选择此 CSV、TXT 
文件后，对应列名称将在“列”(Columns) 区域列出。 CSV、TXT 
只支持一种数据类型“OLE Automation 字符串 (VT_BSTR)”。 在“列”(Columns) 
区域内选择相应列名称后默认选择此数据类型。 

 

按以下步骤选择 CSV/TXT 文件和需要映射的列名称： 
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1. “CSV/TXT”区域提供了一个“CSV 文件名”(CSV filename) 列表框，可显示 CSV 或 TXT 
文件列表。 单击“CSV 文件名”(CSV filename) 字段的下拉箭头并选择合适的 CSV 
文件。 

2. 如果列表中不存在 CSV/TXT 文件，单击“新建 CSV 文件”(New CSV file) 按钮。 “CSV 
创建者”(CSV Creator) 对话框随即打开，从而可利用其中的选项创建新的 CSV 文件。 

 

 

在“CSV 创建者”(CSV Creator) 对话框窗口中，选择“添加”(Add) 
按钮以默认名称创建列条目。 
要对列名称进行自定义，请在此窗口顶部的“列名称”(Column name) 
字段输入列名称。 创建的列显示在“列”(Columns) 文本区域。 借助“上”(UP) 
和“下”(DOWN) 按钮可更改列的顺序。 

 
 

  
说明 
CSV 文件的第一列名称不可使用此由两个大写字母组成的关键字“ID”。 
如果已将“ID”作为第一列的列名称，则单击 CSV 文件后将显示警告消息。 CSV 
文件不支持此行为。 
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3. 在“文件名”(Filename) 文本框中输入一个带扩展名的文件名，并单击“创建”(Create) 
按钮，从而创建 CSV 文件。 至此，文件列表中将具有新建的 CSV 文件。 

如果从列表中选择的文件类型为 UTF-8 格式，则自动选中“UTF-
8”复选框。如果文件为 ANSI 格式，则复选框保持未选中状态。 

4. 在“CSV/TXT 消费方”(CSV/TXT consumer) 选项卡中，选择“CSV 文件名”(CSV 
filename) 字段列表框显示的 CSV 文件。 “列”(Columns) 区域显示“列名称”(column 
name) 及其关联的“数据类型”(Data type)。 

5. 在“列”(Columns) 区域，从列表中选择列名称。 所选列名称显示在“数据值列”(Column 
for data value) 字段中，对应数据类型已选定并显示在“数据类型”(Data type) 字段中。 

6. 要向选定 CSV 文件添加新列，请导航到列表底部并双击包含“<添加新列>”(<Add new 
column>) 文本的行。 

 

 

7. “列名称”(Column name) 对话框随即显示，您可以在其中输入新增列的名称。 
为新增列输入名称并单击“创建”(Create) 按钮。 

新增列将出现在列名称列表中。 可通过重复步骤 6 和 7 来创建任意个列。 

8. 如果列名称的数据类型为“日期/时间”(Date/time)，则时间戳也可写入指定列。 
这种情况下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for 
timestamp) 字段列表框中选择该列。 

9. 借助“过滤器”(Filter) 
字段，您可根据列名称的一个字符或前面几个字符来对列名称进行过滤。 

例如，如果要查看以“S”开头的列名称，在“过滤器”(Filter) 文本框中输入该字符。 
所有以“S”开头的列名称都将显示出来。 

 

最大条目数组态 (Maximum Entry Configuration)： 

借助“最大条目数组态”(Maximum Entry Configuration) 选项卡可对数据进行归档。 
不但可处理连续归档，而且还提供相应的选项，支持在达到最大条目数时进行归档。 
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此外还支持生成归档文件名，并为该功能提供了多个选项。 “归档路径”(Archive path) 
字段允许选择所需归档路径。 
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按以下步骤执行这些归档设置： 

1. 选中“按最大条目数量对文件进行归档”(Archive File at Maximum Entry) 
复选框并在“最大条目数”(Max. entries) 文本框中指定一个值。 
如果该值设为零，则可以在文件中写入任意数量的行。 

 
 

  
说明 

• 默认情况下，“最大条目数”(Max. entries) 字段显示的值为 0。但此值可修改。 

• 必须保证“最大条目数”(Max. entries) 字段不为空。 

• 如果“最大条目数”(Max. entries) 设置为小于 0 
的值或输入负值或为空，将显示错误消息“值应大于或等于 0”(Value should be 
greater than or equal to zero)。 

• 在 CSV/TXT 中“最大条目数”(Max. entries) 的最大值为 
2147483647。任何超出此范围的输入值都无效，并将显示一条错误消息“类型转换

失败”(Type conversion failed)。 
 

  
说明 

• 如果取消选中“按最大条目数量对文件进行归档”(Archive File at Maximum Entry) 
复选框，则“归档文件名生成”(Archive File Name Generation) 
及此选项卡中的其它文件名选择选项都将处于禁用状态。 

 

2. 在“归档文件名生成”(Archive File Name Generation) 
区域中提供了为归档文件生成文件名的选项。 
单击单选按钮选择以下选项中的任意一个。 

– 使用当前日期和时间 

– 使用当前的日期和序列号 

– 使用序列号 

3. 下一步，在提供的文本框中指定归档路径。 
可以在文本框中输入完整路径名，也可使用“...”按钮选择路径。 
如果在归档路径文本框中提供路径，则归档 CSV 文件将在此路径下生成。 
默认状态下，此文本框的路径与基本 CSV 文件所在位置的路径相同。 
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4. “使用专门的文件名”(Use Dedicated File Name) 
复选框允许指定特有的文件名，文件名中可结合序列号和日期、结合日期和时间或者

结合序列号。 如果取消选中此复选框，则将使用基本 CSV 文件名进行归档。 

5. “选择文件名类型”(Select filename type) 字段提供了选择自定义文件名的选项。 

– 要使用自定义文件名，请选择文件名类型“使用自定义文件名”(Use custom 
filename)，然后在“自定义文件名”(Custom file name) 
文本框中输入自定义文件名。 

 
 

 
说明 

序列号 
支持的序列号范围为 1 - 999999999。 
运行期间，如果序列号超过此最大值，则达到该值时系统会自动生成一个跟踪日志。 
一旦达到此上限，IDB 将不会再生成任何新的归档文件。 
数据传送期间将会不断更新相同的文件。 

 

 
 

 
说明 
选中“使用专门的文件名”(Use Dedicated File Name) 复选框后，“选择文件名类型”(Select 
Filename Type) 的下拉列表中将提供“使用自定义文件名”(Use custom filename) 选项。 
选择此选项并在“自定义文件名”(Custom filename) 文本框中输入自定义文件名。 
“使用来自 WinCC 变量的文件名”(Use Filename from WinCC Tag) 
选项仅适用于支持变量的提供方。  

 

 

连接映射 

要在提供方与消费方之间建立连接，需要执行数据列映射。 
定义连接名称是连接设置的第一步。 “连接”(Connection) 
窗口中将显示“默认连接名称”(Default connection name) 选项以指定默认连接名称。 
“连接”(Connect)、“修改连接”(Modify connection)、“删除连接”(Delete connection) 
和“删除所有连接”(Delete all connections) 图标都位于“默认连接名称”(Default connection 
name) 部分下方。 这些按钮可帮助处理连接。 
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说明 

修改连接 
要修改已存在的连接，执行所需的更改并单击“修改”(Modify) 按钮。 
只有在单击“修改”(Modify) 按钮后，才能在“连接”(Connection) 窗口中看到这些更改。 

 

按以下步骤执行提供方与消费方之间的列映射： 

 

1. 从“WinCC OLEDB 提供方”(WinCC OLEDB provider) 
选择变量名称，然后从需要映射的“CSV/TXT 消费方”(CSV/TXT consumer) 
列中选择列名称。 单击“连接”(Connect) 按钮。 

2. 如果提供方与消费方列中数据不匹配，IDB CS 将数据类型修改为 VT_BSTR 
并显示消息“已更改提供方数据类型以适应消费方类型”(The provider data type was 
changed to fit the consumer type)。 下一步，单击“确定”(OK)。 

3. 对要传送的提供方所有元素重复第 1 和第 2 步。 
为提供方和消费方的每个列值都创建一个连接。 

4. 要使用专门的文件名，启用“使用专门的文件名”(Use dedicated filename) 
复选框，然后在“选择文件名类型”(Select filename type) 
字段选中“使用自定义文件名”(Use custom filename)。 

在“自定义文件名”(Custom filename) 文本框中输入自定义文件名。 

5. 在“默认连接名称”(Default Connection name) 
区域内提供的选项中，指定此连接的连接名称，然后单击“连接”(Connect) 按钮。 

 
 

  
说明 

数据类型转换  
如果提供方列与消费方列不匹配，IDB CS 
将转换数据类型，使其与提供方的数据类型相匹配。 
随即将显示出一个状态窗口指示此项更改。 

 

6. 连接名称以及提供方和消费方的数据值都将在“连接”(Connect) 按钮下方显示。 

7. 连接列表将显示在“连接”(Connections) 选项卡中。 
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说明 

时间戳列 
必须先分配时间戳，然后才可连接第一个变量。 
之后，只有在所有条目均已删除且对话框关闭并重新打开后，才能进行添加或更改操作。 
如果传送的新数据来自提供方，时间戳根据本地时间生成。 

 

 

结果 

已创建的连接显示在 IDB CS“设置”(Settings) 窗口的“连接”(Connections) 
选项卡中和项目树节点中。 
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5.2.4 WinCC 用户归档 - OPC 数据访问 

5.2.4.1 第 1 步：创建项目和链接 

简介 

本章介绍在 IDB 组态系统应用程序中创建项目和链接的完整步骤。 
操作目标是创建一个项目，并使相应链接以 WinCC 用户归档作为提供方并以 OPC 
数据访问作为消费方。  

步骤 

 

1. 打开 IDB 组态并通过下述步骤创建项目： 

 

 

– 在 IDB 组态菜单中，选择“项目 > 创建”(Project > Create) 来创建一个新项目。 

– 在“创建新项目”(Create new project) 对话框中，指定一个项目名称，单击 [...] 
按钮并选择项目保存的目标文件夹位置。 

– 在输入所需信息后，选择“创建”(Create) 按钮。这样就创建了一个新项目。 

2. 项目名称将列在“项目树”中。 
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3. 下一步是创建一个链接。 按照下述步骤创建一个提供方与消费方间的链接： 

– 在树结构中右键单击项目名称节点并选择“添加新链接”(Add new link) 选项。 

创建项目之后，默认情况下项目树形结构中项目名称节点下会显示一个新节点“添加

新链接”(Add new link)。  

您也可以通过双击项目树形结构中的“添加新链接”(Add new link) 
节点来创建新的链接。 

– 在显示的“添加新链接”(Add new link) 对话框中，输入唯一的链接名称。 

– 将提供方类型选为“WinCC 用户归档”(WinCC User 
Archive)，将消费方类型选为“OPC 数据访问”(OPC 
DataAccess)，然后单击“确定”(OK) 按钮。 

– 创建的链接将显示在项目树中项目名称下方。 

4. 创建相应的条目“提供方”(Provider)、“消费方”(Consumer)、“设置”(Settings) 
和“连接”(Connections)，并将它们作为树结构中新链接下方的节点。 

 

 

 

结果 

已创建一个项目，其中包含以 WinCC 用户归档作为提供方并以 OPC 
数据访问作为消费方的链接。 
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5.2.4.2 第 2 步： 组态接口 

简介 

您将在本章完成提供方/消费方组态以及传送行为设置。 
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步骤 

1. 在项目树中，双击“提供方”(Provider) 节点，打开“提供方组态”(Provider configuration) 
窗口。 

 

 
 

  
说明 

连接字符串 
在“WinCC 用户归档提供方组态”(WinCC User Archive provider configuration) 
窗口中，选择数据库类型后，“连接字符串”(Connection string) 
字段（位于顶部）将显示数据库连接字符串参数。 

 

2. 在“提供方组态”(Provider configuration) 窗口中，执行以下设置： 

– 输入服务器名称和/或完整的 WinCC 用户归档数据库路径。 

– 从“数据库”(Database) 字段中显示的列表中，选择数据库名称。 
单击下拉列表框来查看此列表。 

– 要想使 Windows 自动进行验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic windows authentication)。 

– 在数据库登录选项所在的部分区域中，输入用户名和密码。 

此信息是登录 WinCC 用户归档数据库时所需的信息。 
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– 单击“测试”(Test) 按钮测试连接。 然后，在项目树中双击“消费方”(Consumer) 
节点。 

 
  

说明 

用户归档 
确保输入已安装 WinCC 的计算机的完整路径。 
如果路径名称无效，“数据库”(Database) 字段不会显示任何表格。 
还要验证用户归档表格是否包含一行或多行数据。 

 

3. 在“消费方组态”(Consumer configuration) 窗口中，执行以下设置： 

 

 

“OPC 数据访问组态”(OPC DataAccess configuration) 部分 

– 单击 [...] 按钮浏览并选择 OPC 服务器。 

 OPC 变量浏览器支持选择服务器。 

– 选择 OPC 服务器后，“节点名称”(Node name) 文本框中将自动显示节点名称。 
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说明 

节点名称 
对于本地 OPC 服务器，节点名称将显示为“本地主机”(local host)。 对于远程 OPC 
服务器，在远程计算机上选择 OPC 服务器后将显示远程计算机的名称。 
从远程计算机上搜索 OPC 服务器时需要使用节点名称。 
如果节点名称无效，OPC 变量浏览器不显示任何内容。 

 
  

说明 
“OPC 服务器”(OPC Server) 和“节点名称”(Node name) 字段均为可编辑字段。 
如果知道 OPC 服务器名称和节点名称信息，可直接在“OPC 服务器”(OPC Server) 
和“节点名称”(Node name) 字段中输入这些信息。 如果节点名称/OPC 
服务器名称无效，OPC 变量浏览器不会显示任何内容。  

 

 

“不良质量项的组态”(Configuration for bad quality item) 部分 

– 在“组态事务错误数变量”(Configure a Variable for number of transaction errors) 
字段单击 [...] 按钮，然后在 OPC 变量浏览器选择变量。 
然后单击“勾号标记”按钮接受更改。 错误变量数由 QUALITY=BAD 
的提供方变量写入。 

– 从下拉列表框中选择特定的数据类型。 

 
 

  
说明 

OPC 变量 
在 OPC 变量浏览器中选择变量后，相应数据类型显示在“数据类型”(Datatype) 字段。 
但如果知道变量名称，将其输入“组态事务错误数变量”(Configure a Variable for 
number of transaction errors) 字段，然后从“数据类型”(Datatype) 
字段的列表中选择数据类型。  

 

 

“异步传送组态”(Asynchronous transfer configuration) 部分 

– 启用复选框选项“异步写入”(Write asynchronous) 以支持异步写入。 

– 在文本框中输入未完成写入事务的最大允许数量。 
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说明 

异步传送 
如果已启用“异步写入”(Write asynchronous) 复选框，则将默认值设置为 10 
并在“未完成的写入事务的最大数量”(Maximum outstanding write transaction) 
文本框显示该值。 禁用此复选框时，该值将重置为 0。在此文本框中可以输入 1 到 40 
之间的值。如果在文本框中输入的值不在此范围内，则将显示错误消息。  

 
  

说明 

异步写入 
异步传送组态对于确保实际数据传送的正确性非常有用。 
示例： 如果已将“未完成写入事务的最大数目”(Maximum outstanding write 
transaction) 组态为 15 且数据传送不正确，则在第 15 个事务失败后，IDB Runtime 
跟踪视图将显示警告消息。 

 

执行链接设置 

1. 在项目树中，在工作区域中双击“设置”(Settings) 节点打开“设置”(Settings) 窗口。 
“设置”(Settings) 窗口由 3 个选项卡组成 -“传送选项”(Transfer 
options)、“连接映射”(Connection mapping) 和“连接”(Connections)。 
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2. 在“传送选项”(Transfer options) 选项卡中，您可以组态提供方的传送行为设置。 

– 从下拉列表中选择“表格名称”(Table name)。 

 
 

  
说明 

方案 

• 在 WinCC User Archive 中，“传送选项”(Transfer options) 
选项卡将自动选择默认方案。 

 

 

3. 单击“事件”(Event) 按钮组态触发器提供方设置。将打开“触发器提供方”(Trigger 
provider)。 

有关“触发器提供方”(Trigger provider) 窗口的说明，请参见“组态触发器 (页 99)”一章 

4. 提供方的传送行为设置将自动保存。 

结果 

已将 WinCC 用户归档接口和 OPC 数据访问组态为消费方，以及提供方传送选项。 
这些元素会显示在 IDB 组态界面的树结构中。 
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5.2.4.3 第 3 步：组态触发器 

简介 

“触发器提供方”(Trigger Provider) 对话框窗口提供 OPC 
设置、触发器组态选项以及组态数据传送触发条件所需的字段。 在“传送选项”(Transfer 
options) 窗口中单击“触发器”(Trigger) 按钮后，将打开此对话框窗口。 

 
 

 
说明 

OPC 变量浏览器 
只有选择 OPC 服务器的名称后，才会在“触发器组态”(Trigger configuration) 部分显示 
OPC 变量。 
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步骤 

1. 在“OPC 设置”(OPC settings) 区域，单击 [...] 按钮选择 OPC 服务器。 OPC 
变量浏览器支持选择服务器。 然后单击“勾号标记”按钮接受更改。 

 

 

2. 如果服务器位于另一台计算机中，请输入该计算机的名称。 OPC 
服务器的树结构在“触发器组态”(Trigger Configuration) 区域显示。 

 
 

  
说明 

节点名称 
对于本地 OPC 服务器，节点名称将显示为“本地主机”(local host)。对于远程 OPC 
服务器，在远程计算机上选择 OPC 
服务器后将显示远程计算机的名称。从远程计算机上搜索 OPC 
服务器时需要使用该“节点名称”。 
如果节点名称无效，OPC 变量浏览器不显示任何内容。 

 
  

说明 
“OPC 服务器”(OPC Server) 和“节点名称”(Node name) 字段均为可编辑字段。 
如果知道 OPC 服务器名称和节点名称信息，可直接在“OPC 服务器”(OPC Server) 
和“节点名称”(Node name) 字段中输入这些信息。如果节点名称/OPC 
服务器名称无效，OPC 变量浏览器不会显示任何内容。  

 

 

3. 您可以在触发器源上定义 OPC 
变量，数据传送的正常/故障状态将保存在“事务安全性对应变量”(Tag for transaction 
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security) 字段中。该值应为 1 字节有符号字符型（例如 VT_I1）。 -1 
代表正常状态，0 代表故障。 

在变量浏览器中选择一个 OPC 服务器变量来保存此信息，并单击“应用项”(Apply item) 
按钮。 

4. 在“触发器组态”(Trigger Configuration) 区域中，选择所需变量并单击“添加项”(Add 
item) 予以接受（每个变量单击一次）。 

所选的变量显示在下面的“变量列表”(Tag list) 中。 

5. 使用“删除项”(Remove item) 
按钮删除标记的项。如果没有任何项带有删除标记，则单击“删除项”(Remove item) 
按钮后，列表中最后一个条目将被删除。 
有关变量列表中各列的详细信息，请参见“变量声明”部分。 

 
 

  
说明 

OPC 服务器 
选择变量并将其添加到变量列表后，如果在“OPC 设置”(OPC Settings) 
区域内切换到另一台 OPC 服务器，将显示一个对话窗口提示您是否要放弃先前设置。 

 

6. 在“触发条件”(Trigger condition) 区域中，可以单击按钮“VB 风格”(Style) 或“JScript 
风格”(JScript Style) 
按钮选择语法类型。如果已创建触发条件，则不能再更改此设置。如果要更改语言，

必须删除“组态触发条件”(Configure Trigger Condition) 字段中的文本。 

有关编程语言的详细介绍，请参见“编程语言”部分。 

7. 用所选语言创建触发条件。使用这些变量在变量列表中显示的别名标识。在显示的文

本框中，使用键盘输入或从“逻辑模式”(Logical patterns) 列表框中选择操作符。 

8. 单击“验证”(Validate) 测试已创建的条件。触发条件将根据“测试值”(Test value) 
列输入的值进行计算。 结果“TRUE”或“FALSE”将显示在消息框中。 

9. 如果触发条件的结果正确无误，则在确认更改后，单击“确定”(OK) 按钮关闭对话框。 

其它信息 

变量声明 

变量声明的列包括： 
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● “数据类型”(Data 
type)：变量的数据类型。如果此处定义的数据类型与服务器上的不匹配，则将尝试转

换该数据类型。 

● “TagID”：OPC 服务器变量的 TagID。 

● “别名”(Alias)：别名用于创建触发条件。此名称必须唯一，而且必须符合所分配编程语

言的命名约定。有关命名约定的详细信息，请参见“有效别名”段落。 

● “确认值”(Confirmation 
value)：确认值是在满足触发条件后变量采用的值并且该值已传送到消费方。默认值为

“<无>”(<Empty>)，即无任何确认值。 

● “测试值”(Test value)：该值仅用于测试触发条件，对之后的数据交换没有任何影响。 
测试值的选择和更改应保证能够测出，触发条件是否在所有运行条件下都可得到预期

结果。 
 

 
说明 

确认值 
该确认值并不会给出是否成功完成事务的信息。 

 

 
说明 

别名的必要性 
不使用 OPC ItemID 
的原因是，它可能不符合变量的有效性标准，例如，变量名中不允许使用“句点”。 

 

 

有效别名 

有效的别名必须符合以下规则： 

● 字母（没有带变音符的字符或 ß）、数字和下划线 (_) 均允许使用。 

● 第一个字符必须是字母或下划线。 

● 别名的长度不限。 

● 不允许使用 VB 脚本或 J 脚本中的关键字。请注意各语言对此的描述。 

● 区分大小写。 
（“tag”与“Tag”不同）。 
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编程语言  

触发条件可以使用 VBScript 或 JScript。 

下表显示了两种语言的操作符类型及其符号： 

 

 

类型 VBScript JScript 

逻辑 NOT（非） NOT ! 

逻辑 AND（与） AND && 

逻辑 OR（或） OR || 

乘 * * 

除 / / 

加 + + 

减 - - 

不等于 <> != 

小于 < < 

大于 > > 

比较 = == 

赋值 <不支持> = 

True true 或 True true 

错误 false 或 False false 

字符串 <引号> <引号> 

建议只使用这些操作符。 有关其它操作符，请参见相应语言的语言介绍 
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说明 

触发事件丢失 
触发取决于 OPC 
服务器的更新速度。在此情况下需注意的是，触发器识别不到更新周期内发生的数据变化

。这意味着，对于变量较快地从 1 变到 0 再变回 1 的情况，OPC 
服务器将不会通知触发器提供方，因为在检查时变量仍为 1 
并且不存在值的变化。也就是说，潜在的真条件并不一定会被识别为真，因而不会引起数

据传送。 
 
由于上述原因，如果在相应的组态中确认值设置为“真”触发条件到“假”触发条件的循环，

并不能保证达到预期结果。如果数据变化过快，“真值”可能会保持不变，从而相应的值会

被遗漏。 
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5.2.4.4 第 4 步： 连接变量 

简介 

本章介绍了在提供方和消费方之间执行连接映射所需的步骤。 

连接变量 

在“设置”(Settings) 窗口中，“连接映射”(Connection mapping) 
选项卡包含所需的字段，这些字段可用于通过所选消费方连接已从 WinCC 
用户归档接口发送的变量。 “连接映射”(Connection mapping) 选项卡将窗口分为 3 部分 

● WinCC 用户归档提供方 

● OPC 数据访问消费方 

● 连接映射设置 

 

“WinCC 用户归档提供方”(WinCC User Archive Provider) 
部分显示在“连接映射”(Connection mapping) 选项卡的左上方。 
此部分为选择要映射的方案、表格名称和列名称提供所需选项。“OPC 
数据访问消费方”(OPC Data Access consumer) 部分显示在“连接映射”(Connection 
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mapping) 选项卡的左下部。 此部分提供了相应选项，借此可从 OPC 变量浏览器的 OPC 
变量列表中选择可与 WinCC 用户归档提供方列建立映射的变量名称。 

 

提供方部分与消费方部分之间的分隔符提供了一个大小调整控点，可借以调整该部分的高

度，从而可清楚地查看此部分中的字段。  

 

“连接映射设置”(Connection mapping settings) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的右侧。 
在此部分中可提供连接名称，同时也提供了选择连接默认名称的选项。 
“连接”(Connect)、“修改连接”(Modify connection)、“删除连接”(Delete connection) 
和“删除所有连接”(Delete all connections) 图标都位于此部分的上部。 

 
 

 
说明 

“连接映射”(Connecting mapping) 选项卡 
为了清楚地查看“连接映射”(Connection mapping) 
选项卡各部分的所有字段，建议使用巡视窗口与项目树中的“折叠”(Collapse) 选项。 
单击“折叠”(Collapse) 图标后，窗口最小化并提供“展开”(Expand) 选项。 
在任何时间，要想恢复窗口，单击“展开”(Expand) 图标即可。  

 

“WinCC 用户归档提供方”(WinCC User Archive Provider) 部分由三个选项卡组成： 

● WinCC 用户归档 

● Where 语句 

● OPC 
 

 
说明 

选择 OPC 服务器 
要在“Where 语句”(Where Statement) 选项卡中组态设置，必须先在对话框“触发器提供方 
(页 99)”(Trigger Provider) 中选择一个 OPC 服务器。 单击“传送选项”(Transfer options) 
选项卡中的“事件”(Event) 按钮访问此对话框窗口。 
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WinCC 用户归档  

1. 在“WinCC 用户归档提供方”(WinCC User Archive Provider) 中，“表格”(Table) 
字段内显示已选择的归档。 通过“方案”(Schema) 
字段中的下拉列表为数据库选择方案（如果适用）。 

2. 列名称在“列”(Columns) 区域中显示。 从列表中选择一个列名称。 
所选的列显示在“数据值列”(Column for data value) 字段中。 
相应的数据类型也会自动显示。 

3. 借助“过滤器”(Filter) 
字段，您可根据列名称的一个字符或前面几个字符来对列名称进行过滤。 

例如，如果要查看以“S”开头的列名称，在“过滤器”(Filter) 文本框中输入该字符。 
所有以“S”开头的列名称都将显示出来。 

4. 接下来，按以下步骤在“OPC 数据访问消费方”(OPC Data Access consumer) 
部分组态变量： 

– 在“OPC 变量浏览器”(OPC tag browser) 内显示的列表中选择变量名称。 在 OPC 
变量浏览器中选择变量后，变量名称将在“变量 ID”(Tag ID) 字段显示。 
数据类型根据所选变量显示在“数据类型”(Datatype) 字段。 

 
 

  
说明 

数据类型转换 
如果提供方与消费方一列的变量数据类型不匹配，IDB CS 
将转换数据类型，使其与提供方变量的数据类型相匹配。 
随即将显示出一个状态窗口指示此项更改。 

 

5. 在右侧的“连接映射设置”(Connection mapping settings) 区域检查连接名称。 
在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

6. 对要传送的“WinCC 用户归档提供方”(WinCC User Archive Provider) 
的所有元素重复第 1 到第 4 步。 
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说明 

数组 
如果 WinCC 用户归档提供方变量的所选数据类型不是数组数据类型，而 OPC 
数据访问消费方变量却是“数组”(Array) 数据类型（即已选中“数组”(Array) 
复选框），则在单击“连接”(Connect) 按钮后会显示一条错误消息。 
由于所选提供方可能不支持“数组”(Array) 数据类型，所以不允许执行连接映射。  

 

 

Where 语句 

描述数据读取访问位置的 SQL 字符串显示在此选项卡中。 “Where 语句”(Where-
statement) 选项卡主要包括“WHERE”部分和用于显示“生成的 SQL 字符串”(Resulting 
SQL-String) 的文本区域。 

 
 

 
说明 

列 
根据 Where 语句中使用的具体表格，以下截屏中显示的列名称可能会有所不同。 
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按以下步骤组态 Where 语句： 

 

1. 单击“添加”(Add) 
按钮打开一个对话框，此对话框所提供的选项可用于选择列以进行内容比较。 

2. 选择要检查特定值的字段名称。 所选字段名称显示在“字段名称”(Fieldname) 字段中。 
此字段名称的数据类型会在“数据类型”(Datatype) 字段中自动选择。 

3. 此“字段名称”(Fieldname) 显示在“WHERE”文本框中。 
从下拉列表中选择用于比较的运算符符号。 

4. 在“OPC 变量”(OPC-variable) 部分选择 OPC 
变量，其值与之前选择的列条目进行比较。 然后单击“确定”(OK) 按钮。 
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5. 条件显示在“Where”部分内的表格中并输入到“生成的 SQL 字符串”(Resulting SQL 
String) 字段中。 

6. 要删除已存在的“生成的 SQL 字符串”，单击“删除”(Remove) 按钮。 

7. 要定义多个条件，请重复第 1 至第 5 步。 

 

 
说明 

SQL 字符串 
 

• 如果组态多个条件，它们以逻辑“AND”连接。 

• 只有在满足条件时才向 IDB 请求数据记录（行）并将其传送。 

• 逻辑“OR”无法实现可选连接。 
 

 

高级 

使用“高级”(Advanced) 按钮，您可在具有多条数据记录时定义排序顺序及行为。 
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● 排序方式 
选择相应选择字段。 然后可定义列名称和排序方向。 

● 对多种结果的行为： 
选择以下选项字段之一，然后单击“确定”(OK) 按钮。 
根据所选的单选按钮，您可决定要执行的操作： 

 

– 错误消息（未传送数据） 

– 提交第一行 

– 提交最后一行 

– 提交所有行 

 

这些选项的标准设置是： 

● 无排序 

● 错误消息（未传送数据） 

 

OPC 选项卡 

“OPC”选项卡所含选项可用于通过 OPC 数据访问消费方变量连接已从 WinCC 
用户归档接口发送的 OPC 变量。 

 
 

 
说明 

选择 OPC 服务器 
要在“OPC”选项卡中组态设置，必须先在对话框“触发器提供方 (页 99)”(Trigger Provider) 
中选择一个 OPC 服务器。 单击“传送选项”(Transfer options) 选项卡中的“事件”(Event) 
按钮访问此对话框窗口。 
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1. 在“WinCC 用户归档提供方”(WinCC User Archive Provider) 区域的 OPC 
选项卡内，显示 OPC 变量浏览器。 
在变量浏览器中，选择应进行值传送操作的变量。 所选变量显示在“变量 ID”(Tag ID) 
字段中。 根据所选内容选择数据类型。 

2. 如果所选变量为数组数据类型，则自动启用“数组”(Array) 复选框。 
此复选框在“数据类型”(Datatype) 字段下面。 

3. 接下来，按以下步骤组态“数据库消费方”(Database consumer) 部分的消费方列： 

– 所选的表格显示在“表格”(Table) 字段中。 从“方案”(Schema) 
文本框的下拉列中选择方案（如果适用）。 

– 列名称在“列”(Columns) 区域中显示。 
如果表格中有各个数据类型的列，也可将时间戳写入表格。 
这种情况下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for 
timestamp) 字段中选择该列。 

4. 选择要与 OPC 变量连接的列名称。所选的列显示在“数据值列”(Column for data 
value) 字段中。 

5. 在右侧的“连接映射设置”(Connection mapping settings) 
区域检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

 
 

  
说明 

数据类型转换  
如果提供方列与消费方列不匹配，IDB CS 
将转换数据类型，使其与提供方的数据类型相匹配。随即将显示出一个状态窗口指示

此项更改。 
 

6. 对要传送的“WinCC 用户归档提供方”(WinCC User Archive Provider) 
所有元素，重复第 1 到第 5 步。 
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说明 

数组 
如果 WinCC 用户归档提供方列的所选数据类型不是数组数据类型，而 OPC 
数据访问消费方变量却是“数组”(Array) 数据类型（即已选中“数组”(Array) 
复选框），则在单击“连接”(Connect) 
按钮后会显示一条错误消息。由于所选提供方可能不支持“数组”(Array) 
数据类型，所以不允许执行连接映射。  

 

结果 

已创建的连接显示在 IDB CS“设置”(Settings) 窗口的“连接”(Connections) 
选项卡中和项目树节点中。 
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5.2.5 在 WinCC Runtime 中查看示例 1 

概述 

本章介绍了在 WinCC Runtime 环境下查看入门指南示例 1 所遵循的步骤。 
安装时随附的入门指南项目包括运行示例项目所需的所有资源。 

 

先决条件 

● 已安装 WinCC V7.3 

● IDB 入门指南项目“idb_getting_started.MCP”已加载到 WinCC 并且项目已激活。 

● IDB CS 应用程序已打开 

● 已在 IDB CS 应用程序中加载“入门指南”项目“IDBProject” 

 

导入组态（XML 文件） 

执行以下给出的步骤来导入随 IDB 
入门指南提供的组态文件并组态相应的提供方/消费方类型： 

1. 在 IDB CS 中，选择“项目 > 导入运行系统组态”(Project > Import Runtime 
Configuration) 来导入组态文件。 

2. 在显示的“打开”(Open) 对话框中，浏览到 IDB 入门指南文件夹 (idb_getting_started) 
并选择组态 XML 文件“idb_getting_started_configfile.xml”。 
下一步，单击“打开”(Open) 按钮。 

3. IDB 入门指南项目组态将导入到 IDB CS 中，项目名称会显示为“IDBProject”。 

4. 左侧的项目树显示一个树状结构，其中包含项目、链接和它们的子节点。 
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5. 在 IDB CS 中，对示例 1 项目的相应提供方/消费方模块执行以下设置： 

– 在 WinCC OLEDB 提供方组态中，选择从 WinCC 导出的 WinCC 项目 XML 文件。 

 
 

  
说明 

报表 
从 WinCC 项目导出 XML 文件后，默认情况下将 XML 文件导出到“报表”(Reports) 
文件夹。 此文件夹位于“IndustrialDataBridge”文件夹中。 “报表”(Reports) 
文件夹中包括导出的 XML 文件。 

 

– 如果要在 WinCC 站上使用，在 WinCC OLEDB 提供方组态中，通过在“WinCC 
站名称”(WinCC station name) 字段中选择下拉列表来选择 WinCC 站名称。 

– 在 WinCC 用户归档提供方/消费方组态中，输入 WinCC 
在计算机中的完整安装路径并选择合适的数据库。 

– 在连接映射选项卡中组态 Where 语句和 WinCC 
用户归档提供方/消费方的高级选项，并创建连接。 

6. 在执行这些步骤后，保存项目并将组态 XML 文件导出到 IDB 入门指南的文件夹 
(idb_getting_started)。 

此 XML 文件将在 IDB Runtime 应用程序中使用。 

 

 
 

 
说明 

打开 IDB 组态 
入门指南项目所需的 IDB 组态也可以在 IDB CS 中使用“IDBProject.ip73”文件来打开。在 
IDB CS 中，单击“项目 > 打开项目”(Project > Open project)，然后单击“浏览”(Browse) 
按钮来浏览文件夹结构。 浏览文件夹中的内容，选择“IDBProject”文件夹中的 .ip73 
文件。 

 

在 WinCC Runtime 中查看示例 1 

WinCC Runtime 中显示的示例 1 包括多个用户控件和按钮，以实现数据传送功能。 
提供的文本控件用于在这些字段中输入所需的值。 IDB Runtime 
控件位于示例画面的中间，包括若干选项以连接链接和启动数据传送。 
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按照以下列出的步骤来连接组态并启动数据传送： 

1. 在 IDB Runtime 控件中，选择“选项”(Options) 按钮以打开“运行系统组态”(Runtime 
configuration) 窗口。 在“NT 服务”(NT Service) 选项卡中，单击“启动服务”(Start 
service) 按钮以启动 IDB Runtime 服务，然后单击“确定”(OK)。 

2. 下一步，单击“打开”(Open) 按钮，以加载 XML 组态文件。 请记住，要选择导出到 
IDB 入门指南文件夹 (idb_getting_started) 中的那个组态 XML 文件。 

3. 在“打开”(Open) 对话框窗口中，浏览 idb_getting_started 
文件夹的内容并选择组态文件“idb_getting_started_configfile.xml”。 选择该 XML 
文件后，单击“打开”(Open) 按钮。 
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4. 随即显示连接列表以及各提供方和消费方的状态。 

 
 

  
说明 

IDB Runtime 中显示的连接 
IDB Runtime 窗口显示属于示例 1 和示例 2 
的所有连接（链接）。使用某个示例时，建议您选择特定于该示例的连接（链接）。  

 

5. 单击“连接”(Connect) 按钮，连接提供方和消费方类型。 

6. 提供方和消费方的状态将立即变成绿色。 下一步，单击“启动”(Start) 
按钮，启动数据传送。 

将过程值发送到 WinCC 用户归档。 

7. 在示例画面的左侧，从列表中选择配方。 根据您的选择，单击“发送过程值”(send 
process values) 按钮，将过程值发送到 WinCC 用户归档。 

8. 用户归档值将显示在“WinCC 用户归档”控件中。 

将报警数据发送到 CSV 

9. 按照示例画面中的格式，在“起始日期”(start date) 和“结束日期”(end date) 
字段中输入起始日期和结束日期。 

10. 单击“发送报警”(send alarm) 
按钮，过滤报警消息归档中的数据并将过滤出的数据传送到 CSV 文件中。 

接收配方 

11. 在 IDB Runtime 中启动数据传送后，配料值即开始从 WinCC 用户归档发送到 OPC 
Data Access 中。 

 

 
 

 
说明 

在示例 1 和示例 2 之间切换 
单击示例画面右下角的按钮，可以在两个示例之间切换。 
需要特别注意的是，在切换到另一个示例之后，需要在做进一步操作之前停止数据传送并

断开数据连接。 
当准备就绪后，可以开始提供方/消费方类型之间的连接，并启动数据传送。 
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结果 

您已经成功执行数据传送，并且通过本示例理解了使用 IDB 
来连接组态链接和启动数据传送的步骤。 
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5.3 入门指南示例 2 

5.3.1 简介 

简介 

本入门指南示例使用一个简单的配方示例来帮助您理解过程动态数据库到 WinCC 
用户归档的数据传送过程。 入门指南示例 2 中对此进行了介绍。 

 

本示例根据用户输入的值来执行数据传送。 另外，在示例 2 
中，用户使用文本框控件来输入生产结果。生产结果可以更新到动态数据库中。 

 

 
 

 
说明 

示例项目 - IDBProject 
随“入门指南”项目提供的示例包括完整的组态，其包含定义完整的组态，以及创建连接时

一并设置的提供方传送选项。 
 

 

示例 2 使用以下组态作为链接。 在示例 2 中，您将在示例项目中创建 2 
个链接“Download_RecipeData”和“Upload_ProductionResult”。  

您可以在 IDB CS 应用程序中查看此组态。 

● 动态数据库作为提供方，WinCC 用户归档作为消费方 

● WinCC 用户归档作为提供方，动态数据库作为消费方 
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● 动态数据库 - WinCC 用户归档 

单击按钮，将所选配方的配料从数据库传送到 WinCC 
用户归档或在数据库中进行检索。 

这些配料显示在示例画面的“WinCC 用户归档”中。 

● WinCC 用户归档 - 动态数据库 

单击按钮将用户输入的生产结果（在加工配料以后）写入到数据库中 

 

为了便于您理解，后续章节介绍了创建或组态连接的具体相关步骤。 每章都按第 1 
步、第 2 步、第 3 步和第 4 步等结构来组织，详细指导您完成整个过程。  

● 动态数据库 - WinCC 用户归档 

● WinCC 用户归档 - 动态数据库 
 

 
说明 

重要信息  
如果不希望执行上述章节中给出的步骤，而是直接在 WinCC Runtime 
中查看示例，则强烈建议您执行“在 WinCC Runtime 中查看示例 2 
(页 171)”一章中所述的步骤。 
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5.3.2 动态数据库 - WinCC 用户归档 

5.3.2.1 第 1 步： 创建项目和链接 

简介 

本章介绍在 IDB 组态系统应用程序中创建项目和链接的完整步骤。 
操作目标是创建一个项目，并使相应链接以动态数据库作为提供方并以 WinCC 
用户归档作为消费方。 

步骤 

 

1. 打开 IDB 组态并通过下述步骤创建项目： 

 

 

– 在 IDB 组态菜单中，选择“项目 > 创建”(Project > Create) 来创建一个新项目。 

– 在“创建新项目”(Create new project) 对话框中，指定一个项目名称，单击 [...] 
按钮并选择项目保存的目标文件夹位置。 

– 在输入所需信息后，选择“创建”(Create) 按钮。 这样就创建了一个新项目。 

2. 项目名称将列在“项目树”中。 
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3. 下一步是创建一个链接。 按照下述步骤创建一个提供方与消费方间的链接： 

 

 

– 在树结构中右键单击项目名称节点并选择“添加新链接”(Add new link) 选项。 

创建项目之后，默认情况下项目树形结构中项目名称节点下会显示一个新节点“添加

新链接”(Add new link)。  

您也可以通过双击项目树形结构中的“添加新链接”(Add new link) 
节点来创建新的链接。 

– 在显示的“添加新链接”(Add new link) 对话框中，输入唯一的链接名称。 

– 将提供方类型选为“动态数据库”(Dynamic Database)，将消费方类型选为“WinCC 
用户归档”(WinCC User Archive)，然后单击“确定”(OK) 按钮。 

– 创建的链接将显示在项目树中项目名称下方。 

4. 创建相应的条目“提供方”(Provider)、“消费方”(Consumer)、“设置”(Settings) 
和“连接”(Connections)，并将它们作为树结构中新链接下方的节点。 

 

结果 

已创建一个项目，其中包含以动态数据库作为提供方并以 WinCC 
用户归档作为消费方的链接。 

 

 



入门指南和示例  
5.3 入门指南示例 2 

 WinCC/IndustrialDataBridge 入门指南 
124 入门指南, 5/2014 

5.3.2.2 第 2 步：组态接口 

简介 

您将在本章完成提供方/消费方组态以及提供方的传送行为设置。  
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步骤 

1. 在项目树中，双击“提供方”(Provider) 节点，打开“提供方组态”(Provider configuration) 
窗口。 

 

 

2. 在“提供方组态”(Provider configuration) 窗口中，执行以下设置： 

– 通过选取合适的单选按钮来选择数据库的类型。 

– 如果在服务器位置存在数据库，请在“服务器”(Server) 字段中输入服务器名称。 

要想使 Windows 自动进行验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic Windows authentication)。 

– 在“数据库”(Database) 字段中，单击 [...] 
按钮，然后从列表或文件夹结构中选择数据库。 
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说明 

服务器名称 
只有在选择 Microsoft Access 
以外的其它数据库时，用于输入服务器名称的“服务器”(Server) 字段、“使用自动 
Windows 身份验证”(Use automatic Windows authentication) 
复选框和用于输入登录信息的各字段才可用。 

 

– 如果已经为数据库设置了用户名和密码，请分别在“用户名”(User name) 
和“密码”(Password) 字段中输入用户名和密码。 

如果要设置空白密码，启用“允许保存密码”(Allow saving password) 复选框。 

– 单击“测试”(Test) 
按钮测试连接。此应用程序将测试数据库连接字符串并验证所选数据库。 

3. 在“消费方组态”(Consumer configuration) 窗口中，执行以下设置： 

 

 

– 输入服务器名称和/或完整的 WinCC 用户归档数据库路径。 

– 从“数据库”(Database) 
字段中显示的列表中，选择数据库名称。单击下拉列表框来查看此列表。 

– 要想使 Windows 自动进行验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic Windows authentication)。 

– 在数据库登录选项所在的部分区域中，输入用户名和密码。 
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此信息是登录 WinCC 用户归档数据库时所需的信息。 

– 单击“测试”(Test) 按钮测试连接。 

 
  

说明 

用户归档 
确保输入已安装 WinCC 的计算机的完整路径。 
如果路径名称无效，“数据库”(Database) 字段不会显示任何表格。 
还要验证用户归档表格是否包含一行或多行数据。 

 

执行链接设置 

1. 在项目树中，在工作区域中双击“设置”(Settings) 节点打开“设置”(Settings) 
窗口。“设置”(Settings) 窗口由 3 个选项卡组成 -“传送选项”(Transfer 
options)、“连接映射”(Connection mapping) 和“连接”(Connections)。 
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2. 在“传送选项”(Transfer options) 选项卡中，您可以组态提供方的传送行为设置。 

 
 

  
说明 

选择方案 

• 如果使用除 Microsoft Access 外的数据库，在选择“表格名称”(Table name) 
之前必须先选择“方案”(Schema)。 

• 将 Microsoft Access 用作数据库时，“方案”(Schema) 
字段显示为禁用状态且不允许选择任何方案。 

 

– 从下拉菜单中先选择“方案”(Schema)（如果对数据库适用），然后选择“表格名称”(
Table name)。 

– 单击“事件”(Event) 按钮组态触发器提供方设置。 将打开“触发器提供方”(Trigger 
provider) 窗口。 

有关“触发器提供方”(Trigger provider) 的说明，请参见“组态触发器 (页 129)”一章。 

3. 提供方的传送行为设置将自动保存。 

 

 
说明 

保存更改 
并不是每次在工作区的编辑器窗口内做出更改时都需要进行保存操作。 
对这些设置所做的更改是自动保存的。 但在项目创建后，您可随时通过选择“项目 > 
保存”(Project > Save) 菜单选项来保存项目。 

 

结果 

已组态动态数据库接口和 WinCC 用户归档作为消费方。 
这些元素会显示在组态界面的树结构中。 
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5.3.2.3 第 3 步：组态触发器 

简介 

“触发器提供方”(Trigger Provider) 对话框窗口提供 OPC 
设置、触发器组态选项以及组态数据传送触发条件所需的字段。 在“传送选项”(Transfer 
options) 窗口中单击“触发器”(Trigger) 按钮后，将打开此对话框窗口。 

 
 

 
说明 

OPC 变量浏览器 
只有选择 OPC 服务器的名称后，才会在“触发器组态”(Trigger configuration) 部分显示 
OPC 变量。 
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步骤 

1. 在“OPC 设置”(OPC settings) 区域，单击 [...] 按钮选择 OPC 服务器。 OPC 
变量浏览器支持选择服务器。 然后单击“勾号标记”按钮接受更改。 

 

 

2. 如果服务器位于另一台计算机中，请输入该计算机的名称。 OPC 
服务器的树结构在“触发器组态”(Trigger Configuration) 区域显示。 

 
 

  
说明 

节点名称 
对于本地 OPC 服务器，节点名称将显示为“本地主机”(local host)。对于远程 OPC 
服务器，在远程计算机上选择 OPC 
服务器后将显示远程计算机的名称。从远程计算机上搜索 OPC 
服务器时需要使用该“节点名称”。 
如果节点名称无效，OPC 变量浏览器不显示任何内容。 

 
  

说明 
“OPC 服务器”(OPC Server) 和“节点名称”(Node name) 字段均为可编辑字段。 
如果知道 OPC 服务器名称和节点名称信息，可直接在“OPC 服务器”(OPC Server) 
和“节点名称”(Node name) 字段中输入这些信息。如果节点名称/OPC 
服务器名称无效，OPC 变量浏览器不会显示任何内容。  

 

 

3. 您可以在触发器源上定义 OPC 
变量，数据传送的正常/故障状态将保存在“事务安全性对应变量”(Tag for transaction 
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security) 字段中。该值应为 1 字节有符号字符型（例如 VT_I1）。 -1 
代表正常状态，0 代表故障。 

在变量浏览器中选择一个 OPC 服务器变量来保存此信息，并单击“应用项”(Apply item) 
按钮。 

4. 在“触发器组态”(Trigger Configuration) 区域中，选择所需变量并单击“添加项”(Add 
item) 予以接受（每个变量单击一次）。 

所选的变量显示在下面的“变量列表”(Tag list) 中。 

5. 使用“删除项”(Remove item) 
按钮删除标记的项。如果没有任何项带有删除标记，则单击“删除项”(Remove item) 
按钮后，列表中最后一个条目将被删除。 
有关变量列表中各列的详细信息，请参见“变量声明”部分。 

 
 

  
说明 

OPC 服务器 
选择变量并将其添加到变量列表后，如果在“OPC 设置”(OPC Settings) 
区域内切换到另一台 OPC 服务器，将显示一个对话窗口提示您是否要放弃先前设置。 

 

6. 在“触发条件”(Trigger condition) 区域中，可以单击按钮“VB 风格”(Style) 或“JScript 
风格”(JScript Style) 
按钮选择语法类型。如果已创建触发条件，则不能再更改此设置。如果要更改语言，

必须删除“组态触发条件”(Configure Trigger Condition) 字段中的文本。 

有关编程语言的详细介绍，请参见“编程语言”部分。 

7. 用所选语言创建触发条件。使用这些变量在变量列表中显示的别名标识。在显示的文

本框中，使用键盘输入或从“逻辑模式”(Logical patterns) 列表框中选择操作符。 

8. 单击“验证”(Validate) 测试已创建的条件。触发条件将根据“测试值”(Test value) 
列输入的值进行计算。 结果“TRUE”或“FALSE”将显示在消息框中。 

9. 如果触发条件的结果正确无误，则在确认更改后，单击“确定”(OK) 按钮关闭对话框。 

其它信息 

变量声明 

变量声明的列包括： 
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● “数据类型”(Data 
type)：变量的数据类型。如果此处定义的数据类型与服务器上的不匹配，则将尝试转

换该数据类型。 

● “TagID”：OPC 服务器变量的 TagID。 

● “别名”(Alias)：别名用于创建触发条件。此名称必须唯一，而且必须符合所分配编程语

言的命名约定。有关命名约定的详细信息，请参见“有效别名”段落。 

● “确认值”(Confirmation 
value)：确认值是在满足触发条件后变量采用的值并且该值已传送到消费方。默认值为

“<无>”(<Empty>)，即无任何确认值。 

● “测试值”(Test value)：该值仅用于测试触发条件，对之后的数据交换没有任何影响。 
测试值的选择和更改应保证能够测出，触发条件是否在所有运行条件下都可得到预期

结果。 
 

 
说明 

确认值 
该确认值并不会给出是否成功完成事务的信息。 

 

 
说明 

别名的必要性 
不使用 OPC ItemID 
的原因是，它可能不符合变量的有效性标准，例如，变量名中不允许使用“句点”。 

 

 

有效别名 

有效的别名必须符合以下规则： 

● 字母（没有带变音符的字符或 ß）、数字和下划线 (_) 均允许使用。 

● 第一个字符必须是字母或下划线。 

● 别名的长度不限。 

● 不允许使用 VB 脚本或 J 脚本中的关键字。请注意各语言对此的描述。 

● 区分大小写。 
（“tag”与“Tag”不同）。 

 



入门指南和示例  
5.3 入门指南示例 2 

 WinCC/IndustrialDataBridge 入门指南 
134 入门指南, 5/2014 

编程语言  

触发条件可以使用 VBScript 或 JScript。 

下表显示了两种语言的操作符类型及其符号： 

 

 

类型 VBScript JScript 

逻辑 NOT（非） NOT ! 

逻辑 AND（与） AND && 

逻辑 OR（或） OR || 

乘 * * 

除 / / 

加 + + 

减 - - 

不等于 <> != 

小于 < < 

大于 > > 

比较 = == 

赋值 <不支持> = 

True true 或 True true 

错误 false 或 False false 

字符串 <引号> <引号> 

建议只使用这些操作符。 有关其它操作符，请参见相应语言的语言介绍 
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说明 

触发事件丢失 
触发取决于 OPC 
服务器的更新速度。在此情况下需注意的是，触发器识别不到更新周期内发生的数据变化

。这意味着，对于变量较快地从 1 变到 0 再变回 1 的情况，OPC 
服务器将不会通知触发器提供方，因为在检查时变量仍为 1 
并且不存在值的变化。也就是说，潜在的真条件并不一定会被识别为真，因而不会引起数

据传送。 
 
由于上述原因，如果在相应的组态中确认值设置为“真”触发条件到“假”触发条件的循环，

并不能保证达到预期结果。如果数据变化过快，“真值”可能会保持不变，从而相应的值会

被遗漏。 
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5.3.2.4 第 4 步：连接变量 

简介 

本章介绍了在提供方和消费方之间执行连接映射所需的步骤。 

连接变量 

在“设置”(Settings) 窗口中，“连接映射”(Connection mapping) 
选项卡包括连接从具有选定数据消费方的动态数据库接口发送的变量所需字段。 
“连接映射”(Connection mapping) 选项卡将窗口分为 3 部分 

● 动态数据库提供方 

● WinCC 用户归档消费方 

● 连接映射设置 

 

 
 

 
说明 

选择 OPC 服务器 
要在“Where 语句”(Where Statement) 选项卡中组态设置，必须在“触发器提供方 
(页 129)”(Trigger Provider) 对话框的链接设置中选择 OPC 服务器。 
单击“传送选项”(Transfer options) 选项卡中的“事件”(Event) 按钮访问此对话框窗口。 
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动态数据库  

“动态数据库提供方”(Dynamic database provider) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的左上部分。 
此部分为选择要映射的方案、表格名称和列名称提供所需选项。 “WinCC 
用户归档消费方”(WinCC User Archive Consumer) 部分显示在“连接映射”(Connection 
mapping) 选项卡的左下方。 
通过使用此部分中提供的选项，可选择要映射到动态数据库（提供方）中已有列的方案、

表格名称和列名称。 

提供方部分与消费方部分之间的分隔符提供了一个大小调整控点，可借以调整该部分的高

度，从而可清楚地查看此部分中的字段。 

“连接映射设置”(Connection mapping settings) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的右侧。 
在此部分中可提供连接名称，同时也提供了选择连接默认名称的选项。“连接”(Connect)、
“修改连接”(Modify connection)、“删除连接”(Delete connection) 和“删除所有连接”(Delete 
all connections) 图标都位于此部分的上部。 
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说明 

选择方案 

• 如果使用除 Microsoft Access 外的数据库，在选择“表格名称”(Table name) 
之前必须先选择“方案”(Schema)。 

• 将 Microsoft Access 用作数据库时，“方案”(Schema) 
字段显示为禁用状态且不允许选择任何方案。 

 

 

“动态数据库提供方”(Dynamic Database provider) 部分由三个选项卡组成： 

● 动态数据库提供方 

● Where 语句 

● OPC 

 

Where 语句  
 

 
说明 

选择 OPC 服务器 
要在“Where 语句”(Where Statement) 选项卡中组态设置，必须在“触发器提供方”(Trigger 
Provider) 对话框的链接设置中选择 OPC 服务器。单击“传送选项”(Transfer options) 
选项卡中的“事件”(Event) 按钮访问此对话框窗口。 

 

 
 

 
说明 

列 
根据 Where 语句中使用的具体表格，截屏中显示的列名称可能会有所不同。 
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描述数据读取访问位置的 SQL 字符串显示在此选项卡中。“Where 语句”(Where-
statement) 选项卡主要包括“WHERE”部分和用于显示“生成的 SQL 字符串”(Resulting 
SQL-String) 的文本区域。  

按以下步骤组态 Where 语句： 

 

1. 在“Where 语句”(Where statement) 选项卡中，单击“添加”(Add) 
按钮打开一个对话框，其中包含的选项可用于选择列以进行内容比较。 

2. 选择要检查特定值的字段名称。所选字段名称显示在“字段名称”(Fieldname) 字段中。 
此字段名称的数据类型会在“数据类型”(Data type) 字段中自动选择。 

3. 此“字段名称”(Fieldname) 
显示在“WHERE”文本框中。从下拉列表中选择用于比较的运算符符号。 



入门指南和示例  
5.3 入门指南示例 2 

 WinCC/IndustrialDataBridge 入门指南 
140 入门指南, 5/2014 

4. 在“OPC 变量”(OPC-variable) 部分选择 OPC 
变量，其值与之前选择的列条目进行比较。 然后单击“确定”(OK) 按钮。 

5. 条件显示在“Where”部分内的表格中并输入到“生成的 SQL 字符串”(Resulting SQL 
String) 字段中。 

6. 要删除已存在的“生成的 SQL 字符串”，单击“删除”(Remove) 按钮。 

7. 要定义多个条件，请重复第 1 至第 5 步。 

 

 
说明 

SQL 字符串 
 

• 如果组态多个条件，它们以逻辑“AND”连接。 

• 只有在满足条件时才向 IDB 请求数据记录（行）并将其传送。 

• 逻辑“OR”无法实现可选连接。 
 

 

 

高级： 

使用“高级”(Advanced) 按钮，您可在具有多条数据记录时定义排序顺序及行为。 
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● 排序方式 
选择相应选择字段。 然后可定义列名称和排序方向。 

● 对多种结果的行为： 
选择以下选项字段之一，然后单击“确定”(OK) 按钮。 
根据所选的单选按钮，您可决定要执行的操作： 

 

– 错误消息（未传送数据） 

– 提交第一行 

– 提交最后一行 

– 提交所有行 

 

这些选项的标准设置是： 

● 无排序 

● 错误消息（未传送数据） 

 

OPC 选项卡 

 
 

 
说明 

选择 OPC 服务器 
要在“OPC”选项卡中组态设置，必须在“触发器提供方 (页 129)”(Trigger Provider) 
对话框的链接设置中选择 OPC 服务器。 单击“传送选项”(Transfer options) 
选项卡中的“事件”(Event) 按钮访问此对话框窗口。 

 

 

1. 在“动态数据库提供方”(Dynamic database provider) 区域中，导航到 OPC 选项卡。 
OPC 选项卡主要包括 OPC 变量浏览器和“组态提供方 OPC 变量”(Configure provider 
OPC tag) 区域。 

2. 在 OPC 变量浏览器中，选择应进行值传送操作的变量。 所选变量显示在“变量 
ID”(TagID) 字段。根据所选内容选择数据类型。 

3. 如果所选变量为数组数据类型，则自动启用“数组”(Array) 
复选框。此复选框位于“数据类型”(Data type) 字段下面。 
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4. 接下来，按以下步骤组态“数据库消费方”(Database consumer) 部分的消费方变量： 

– 所选的表格显示在“表格”(Table) 字段中。 
方案（如果已在消费方选择）显示在“方案”(Schema) 字段中。 

– 列名称在“列”(Columns) 
区域中显示。如果表格中有各个数据类型的列，也可将时间戳写入表格。 
这种情况下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for 
timestamp) 字段中选择该列。 

5. 选择要与 OPC 变量连接的列名称。 所选列显示在 WinCC 
用户归档消费方的“数据值列”(Column for data value) 字段中。 

6. 在右侧的“连接映射设置”(Connection mapping settings) 
区域检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。单击“连接”(Connect) 按钮确认输入内容。 

7. 对要传送的“动态数据库”(Dynamic database) 所有元素，重复第 1 到第 5 步。 

 

 
说明 

数组 
如果 OPC 
提供方变量的数据类型是数组且数据库消费方列的数据类型不是数组，则在单击“连接”(C
onnect) 按钮后，“OPC”选项卡中的“数组”(Array) 复选框自动取消选中。 

 

 

WinCC 用户归档消费方 

在“连接映射”(Connection mapping) 选项卡中，“WinCC 用户归档消费方”(WinCC User 
Archive consumer) 部分显示在该选项卡的左下部。 
该部分位于“动态数据库提供方”(Dynamic database provider) 部分之下。 “WinCC 
用户归档消费方”(WinCC User Archive consumer) 包括以下 3 个选项卡： 

● WinCC 用户归档消费方 

● Where 语句 

● 删除设置 
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“WinCC 用户归档消费方”(WinCC User Archive consumer) 
部分中提供了多个选项，可用于选择要映射到动态数据库提供方中已有列的方案、表格名

称和列名称。 在动态数据库提供方列以及在“Where 语句”(Where statement) 
选项卡中选择的列（属于 WinCC 用户归档消费方）之间创建一个特定的连接。 
您可创建一个新连接或修改现有连接，以便将“Where 语句”(Where statement) 
应用于所选列。 

 

Where 语句 

为了在 WinCC 用户归档消费方中选择列，需对 Where 语句进行组态。 “Where 
语句”(Where-statement) 选项卡主要包括“Where 语句”组态部分和异常处理部分。 

 

如需执行连接映射，执行以下步骤： 

1. 在“动态数据库提供方”(Dynamic database provider) 部分（左上方），选择要应用 
Where 语句的列（WinCC 用户归档消费方）。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 
字段中。数据类型将根据所选列名称自动选择。 

3. 在“Where 列”(Where-column) 字段，选择要用于 Where 语句的列。 
如果要向数据库中写入一个值，则会比较此列与连接的提供方列。 
只更新两个值匹配的行。 
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4. 如果在消费方一行中所做选择不唯一，则在“异常行为”(Exceptional behaviour) 
部分中定义行为： 

– 错误消息： 不覆盖任何消费方行，发出一条错误消息作为 IDB Runtime 
跟踪视图中的输出。 

– 更改所有行： 覆盖所有已选中的消费方行。 

– 如果不存在带有键（主键）的行，则使用“启用插入”(Enable Insert) 
复选框定义行为。 如果选择此选项，则创建一个带有相应键的新行。 

 
  

说明 

同时用作键列和消费方列 
为了通过组态获得更多的设置功能，可将一个列同时用作键列和目标列。 
请注意，这将引起数据库中的数据不一致和/或对 WinCC 
用户归档消费方的后续访问可能导致出错。 

 

5. 在“连接映射设置”(Connection mapping settings) 
区域（右侧）中检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

 

删除设置 

使用“WinCC 用户归档消费方”(WinCC User Archive 
consumer)，可删除来自用户归档的数据记录。 这需要将提供方列连接到消费方列。 
如果满足删除条件，就会从用户归档中删除消费方列的数据记录。 “删除”(Delete) 
的优先级高于“插入”(Insert) 和“更新”(Update) 操作。 

 

如需执行连接映射，执行以下步骤： 

1. 在“动态数据库提供方”(Dynamic database provider) 
部分（左上方），选择应进行值比较操作的列。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 
字段中。数据类型将根据所选列名称自动选择。 
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3. 在“删除设置”(Delete settings) 选项卡中，启用“可删除”(Delete possible) 
复选框并在“删除变量的值”(Value for delete variable) 字段内输入删除列的值。 

如果连接提供方列采用此值，则会根据 Where 
语句从用户归档中删除包含此值的相应数据记录。 

4. 在连接区域（右侧）检查连接名称。 在“连接”(Connection) 
字段中输入连接的唯一名称或使用默认名称惯例。单击“连接”(Connect) 
按钮确认输入内容。 

 

连接映射 

 

1. 在“动态数据库提供方”(Dynamic database provider) 
中，所选的归档显示在“表格”(Table) 字段中。 从“方案”(Schema) 
文本框的下拉列中选择方案（如果适用）。 

2. 列名称在“列”(Columns) 
区域中显示。从列表中选择一个列名称。所选的列显示在“数据值列”(Column for data 
value) 字段中。相应的数据类型也会自动显示。 

3. 借助“过滤器”(Filter) 
字段，您可根据列名称的一个字符或前面几个字符来对列名称进行过滤。 

例如，如果要查看以“S”开头的列名称，在“过滤器”(Filter) 文本框中输入该字符。 
所有以“S”开头的列名称都将显示出来。 

4. 接下来，按以下步骤组态“WinCC 用户归档消费方”(WinCC User Archive consumer) 
部分的消费方变量： 

– 所选的表格显示在“表格”(Table) 字段中。从“方案”(Schema) 
文本框的下拉列中选择方案（如果适用）。 

– 列名称在“列”(Columns) 
区域中显示。如果表格中有各个数据类型的列，也可将时间戳写入表格。这种情况

下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for timestamp) 
字段中选择该列。 

5. 选择要与“动态数据库”(Dynamic database) 列连接的列名称。 

所选的列显示在“数据值列”(Column for data value) 字段中。 

6. 在右侧的“连接映射设置”(Connection mapping settings) 
区域检查连接名称。在“连接名称”(Connection name) 
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字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。单击“连接”(Connect) 按钮确认输入内容。 

 
 

  
说明 

数据类型转换 
如果提供方列与消费方列不匹配，IDB CS 
将转换数据类型，使其与提供方的数据类型相匹配。随即将显示出一个状态窗口指示

此项更改。 
 

 

7. 对要传送的“动态数据库提供方”(Dynamic database provider) 所有元素，重复第 1 
到第 6 步。 
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5.3.3 WinCC 用户归档 - 动态数据库 

5.3.3.1 第 1 步：创建项目和链接 

简介 

本章介绍在 IDB 组态系统应用程序中创建项目和链接的完整步骤。 
操作目标是创建一个项目，并使相应链接以 WinCC 
用户归档作为提供方并以动态数据库作为消费方。 

步骤 

 

1. 打开 IDB 组态并通过下述步骤创建项目： 

 

 

– 在 IDB 组态菜单中，选择“项目 > 创建”(Project > Create) 来创建一个新项目。 

– 在“创建新项目”(Create new project) 对话框中，指定一个项目名称，单击 [...] 
按钮并选择项目保存的目标文件夹位置。 

– 在输入所需信息后，选择“创建”(Create) 按钮。这样就创建了一个新项目。 

2. 项目名称将列在“项目树”中。 
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3. 下一步是创建一个链接。 按照下述步骤创建一个提供方与消费方间的链接： 

 

 

– 在树结构中右键单击项目名称节点并选择“添加新链接”(Add new link) 选项。 

创建项目之后，默认情况下项目树形结构中项目名称节点下会显示一个新节点“添加

新链接”(Add new link)。  

您也可以通过双击项目树形结构中的“添加新链接”(Add new link) 
节点来创建新的链接。 

– 在显示的“添加新链接”(Add new link) 对话框中，输入唯一的链接名称。 

– 为提供方类型选择“WinCC 用户归档”(WinCC User 
Archive)，为消费方类型选择“动态数据库”(Dynamic 
Database)，然后单击“确定”(OK) 按钮。 

– 创建的链接将显示在项目树中项目名称下方。 

4. 创建相应的条目“提供方”(Provider)、“消费方”(Consumer)、“设置”(Settings) 
和“连接”(Connections)，并将它们作为树结构中新链接下方的节点。 

 

结果 

已创建一个项目，其中包含以 WinCC 
用户归档作为提供方并以动态数据库作为消费方的链接。 
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5.3.3.2 第 2 步：组态接口 

简介 

您将在本章完成提供方/消费方组态以及提供方的传送行为设置。 
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步骤 

1. 在项目树中，双击“提供方”(Provider) 节点，打开“提供方组态”(Provider configuration) 
窗口。 

 

 

2. 在“提供方组态”(Provider configuration) 窗口中，执行以下设置： 

– 输入服务器名称和/或完整的 WinCC 用户归档数据库路径。 

– 从“数据库”(Database) 字段中显示的列表中，选择数据库名称。 
单击下拉列表框来查看此列表。 

– 要启用 Windows 自动身份验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic windows authentication)。 

– 在数据库登录选项所在的部分区域中，输入用户名和密码。 

此信息是登录 WinCC 用户归档数据库时所需的信息。 

– 单击“测试”(Test) 按钮测试连接。 然后，在项目树中双击“消费方”(Consumer) 
节点。 
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说明 

用户归档 
确保输入已安装 WinCC 的计算机的完整路径。 
如果路径名称无效，“数据库”(Database) 字段不会显示任何表格。 
还要验证用户归档表格是否包含一行或多行数据。 

 

3. 在“消费方组态”(Consumer configuration) 窗口中，执行以下设置： 

 

 

– 通过选取合适的单选按钮来选择数据库的类型。 

– 如果在服务器位置存在数据库，请在“服务器”(Server) 字段中输入服务器名称。 

要启用 Windows 自动身份验证，则需选中复选框“使用自动 Windows 
身份验证”(Use automatic Windows authentication)。 

– 在“数据库”(Database) 字段中，单击 [...] 
按钮，然后从列表或文件夹结构中选择数据库。 
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说明 

服务器名称 
只有在选择 Microsoft Access 
以外的其它数据库时，用于输入服务器名称的“服务器”(Server) 字段、“使用自动 
Windows 身份验证”(Use automatic Windows authentication) 
复选框和用于输入登录信息的各字段才可用。 

 

– 如果已经设置数据库的用户名和密码，请分别在“用户名”(User name) 
和“密码”(Password) 字段中输入用户名和密码。 

如果要设置空白密码，启用“允许保存密码”(Allow saving password) 复选框。 

– 单击“测试”(Test) 按钮测试连接。 
此应用程序将测试数据库连接字符串并验证所选数据库。 

 

执行链接设置 

1. 在项目树中，在工作区域中双击“设置”(Settings) 节点打开“设置”(Settings) 窗口。 
“设置”(Settings) 窗口由 3 个选项卡组成 -“传送选项”(Transfer 
options)、“连接映射”(Connection mapping) 和“连接”(Connections)。 

 

 



 入门指南和示例 
 5.3 入门指南示例 2 

WinCC/IndustrialDataBridge 入门指南 
入门指南, 5/2014 153 

2. 在“传送选项”(Transfer options) 选项卡中，您可以组态提供方的传送行为设置。 

– 从下拉列表中选择“表格名称”(Table name)。 

 
 

  
说明 

方案 

• 在 WinCC User Archive 中，“传送选项”(Transfer options) 
选项卡将自动选择默认方案。 

 

 

3. 单击“事件”(Event) 按钮组态触发器提供方设置。 将打开“触发器提供方”(Trigger 
provider) 对话框。 

有关“组态触发器”(Config Trigger) 对话框的说明，请参见“组态触发器 (页 154)”一章 

4. 提供方的传送行为设置将自动保存。 

 

 
说明 

保存更改 
并不是每次在工作区的编辑器窗口内做出更改时都需要进行保存操作。 
对这些设置所做的更改是自动保存的。 但在项目创建后，您可随时通过选择“项目 > 
保存”(Project > Save) 菜单选项来保存项目。 

 

结果 

已组态 WinCC 用户归档接口和动态数据库消费方，包括提供方传送选项。 
这些元素会显示在 IDB 组态界面的树结构中。 
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5.3.3.3 第 3 步：组态触发器 

简介 

“触发器提供方”(Trigger Provider) 对话框窗口提供 OPC 
设置、触发器组态选项以及组态数据传送触发条件所需的字段。 在“传送选项”(Transfer 
options) 窗口中单击“触发器”(Trigger) 按钮后，将打开此对话框窗口。 

 
 

 
说明 

OPC 变量浏览器 
只有选择 OPC 服务器的名称后，才会在“触发器组态”(Trigger configuration) 部分显示 
OPC 变量。 
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步骤 

1. 在“OPC 设置”(OPC settings) 区域，单击 [...] 按钮选择 OPC 服务器。 OPC 
变量浏览器支持选择服务器。 然后单击“勾号标记”按钮接受更改。 

 

 

2. 如果服务器位于另一台计算机中，请输入该计算机的名称。 OPC 
服务器的树结构在“触发器组态”(Trigger Configuration) 区域显示。 

 
 

  
说明 

节点名称 
对于本地 OPC 服务器，节点名称将显示为“本地主机”(local host)。对于远程 OPC 
服务器，在远程计算机上选择 OPC 
服务器后将显示远程计算机的名称。从远程计算机上搜索 OPC 
服务器时需要使用该“节点名称”。 
如果节点名称无效，OPC 变量浏览器不显示任何内容。 

 
  

说明 
“OPC 服务器”(OPC Server) 和“节点名称”(Node name) 字段均为可编辑字段。 
如果知道 OPC 服务器名称和节点名称信息，可直接在“OPC 服务器”(OPC Server) 
和“节点名称”(Node name) 字段中输入这些信息。如果节点名称/OPC 
服务器名称无效，OPC 变量浏览器不会显示任何内容。  

 

 

3. 您可以在触发器源上定义 OPC 
变量，数据传送的正常/故障状态将保存在“事务安全性对应变量”(Tag for transaction 
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security) 字段中。该值应为 1 字节有符号字符型（例如 VT_I1）。 -1 
代表正常状态，0 代表故障。 

在变量浏览器中选择一个 OPC 服务器变量来保存此信息，并单击“应用项”(Apply item) 
按钮。 

4. 在“触发器组态”(Trigger Configuration) 区域中，选择所需变量并单击“添加项”(Add 
item) 予以接受（每个变量单击一次）。 

所选的变量显示在下面的“变量列表”(Tag list) 中。 

5. 使用“删除项”(Remove item) 
按钮删除标记的项。如果没有任何项带有删除标记，则单击“删除项”(Remove item) 
按钮后，列表中最后一个条目将被删除。 
有关变量列表中各列的详细信息，请参见“变量声明”部分。 

 
 

  
说明 

OPC 服务器 
选择变量并将其添加到变量列表后，如果在“OPC 设置”(OPC Settings) 
区域内切换到另一台 OPC 服务器，将显示一个对话窗口提示您是否要放弃先前设置。 

 

6. 在“触发条件”(Trigger condition) 区域中，可以单击按钮“VB 风格”(Style) 或“JScript 
风格”(JScript Style) 
按钮选择语法类型。如果已创建触发条件，则不能再更改此设置。如果要更改语言，

必须删除“组态触发条件”(Configure Trigger Condition) 字段中的文本。 

有关编程语言的详细介绍，请参见“编程语言”部分。 

7. 用所选语言创建触发条件。使用这些变量在变量列表中显示的别名标识。在显示的文

本框中，使用键盘输入或从“逻辑模式”(Logical patterns) 列表框中选择操作符。 

8. 单击“验证”(Validate) 测试已创建的条件。触发条件将根据“测试值”(Test value) 
列输入的值进行计算。 结果“TRUE”或“FALSE”将显示在消息框中。 

9. 如果触发条件的结果正确无误，则在确认更改后，单击“确定”(OK) 按钮关闭对话框。 

其它信息 

变量声明 

变量声明的列包括： 
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● “数据类型”(Data 
type)：变量的数据类型。如果此处定义的数据类型与服务器上的不匹配，则将尝试转

换该数据类型。 

● “TagID”：OPC 服务器变量的 TagID。 

● “别名”(Alias)：别名用于创建触发条件。此名称必须唯一，而且必须符合所分配编程语

言的命名约定。有关命名约定的详细信息，请参见“有效别名”段落。 

● “确认值”(Confirmation 
value)：确认值是在满足触发条件后变量采用的值并且该值已传送到消费方。默认值为

“<无>”(<Empty>)，即无任何确认值。 

● “测试值”(Test value)：该值仅用于测试触发条件，对之后的数据交换没有任何影响。 
测试值的选择和更改应保证能够测出，触发条件是否在所有运行条件下都可得到预期

结果。 
 

 
说明 

确认值 
该确认值并不会给出是否成功完成事务的信息。 

 

 
说明 

别名的必要性 
不使用 OPC ItemID 
的原因是，它可能不符合变量的有效性标准，例如，变量名中不允许使用“句点”。 

 

 

有效别名 

有效的别名必须符合以下规则： 

● 字母（没有带变音符的字符或 ß）、数字和下划线 (_) 均允许使用。 

● 第一个字符必须是字母或下划线。 

● 别名的长度不限。 

● 不允许使用 VB 脚本或 J 脚本中的关键字。请注意各语言对此的描述。 

● 区分大小写。 
（“tag”与“Tag”不同）。 
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编程语言  

触发条件可以使用 VBScript 或 JScript。 

下表显示了两种语言的操作符类型及其符号： 

 

 

类型 VBScript JScript 

逻辑 NOT（非） NOT ! 

逻辑 AND（与） AND && 

逻辑 OR（或） OR || 

乘 * * 

除 / / 

加 + + 

减 - - 

不等于 <> != 

小于 < < 

大于 > > 

比较 = == 

赋值 <不支持> = 

True true 或 True true 

错误 false 或 False false 

字符串 <引号> <引号> 

建议只使用这些操作符。 有关其它操作符，请参见相应语言的语言介绍 
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说明 

触发事件丢失 
触发取决于 OPC 
服务器的更新速度。在此情况下需注意的是，触发器识别不到更新周期内发生的数据变化

。这意味着，对于变量较快地从 1 变到 0 再变回 1 的情况，OPC 
服务器将不会通知触发器提供方，因为在检查时变量仍为 1 
并且不存在值的变化。也就是说，潜在的真条件并不一定会被识别为真，因而不会引起数

据传送。 
 
由于上述原因，如果在相应的组态中确认值设置为“真”触发条件到“假”触发条件的循环，

并不能保证达到预期结果。如果数据变化过快，“真值”可能会保持不变，从而相应的值会

被遗漏。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 入门指南和示例 
 5.3 入门指南示例 2 

WinCC/IndustrialDataBridge 入门指南 
入门指南, 5/2014 161 

5.3.3.4 第 4 步： 连接变量 

简介 

本章介绍了在提供方和消费方之间执行连接映射所需的步骤。 

连接变量 

在“设置”(Settings) 窗口中，“连接映射”(Connection mapping) 
选项卡包含所需的字段，这些字段可用于通过所选消费方连接已从 WinCC 
用户归档接口发送的变量。 “连接映射”(Connection mapping) 选项卡将窗口分为 3 部分 

● WinCC 用户归档提供方 

● 动态数据库消费方 

● 连接映射设置 
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WinCC 用户归档提供方 

“WinCC 用户归档提供方”(WinCC User Archive Provider) 
部分显示在“连接映射”(Connection mapping) 选项卡的左上方。 
此部分为选择要映射的方案、表格名称和列名称提供所需选项。 
“动态数据库消费方”(Dynamic Database consumer) 
部分位于提供方部分下，并列出了能够映射到 WinCC 用户归档数据库中已有列的列值。 

提供方部分与消费方部分之间的分隔符提供了一个大小调整控点，可借以调整该部分的高

度，从而可清楚地查看此部分中的字段。 

“连接映射设置”(Connection mapping settings) 部分显示在“连接映射”(Connection 
mapping) 选项卡中的右侧。 
在此部分中可提供连接名称，同时也提供了选择连接默认名称的选项。 
“连接”(Connect)、“修改连接”(Modify connection)、“删除连接”(Delete connection) 
和“删除所有连接”(Delete all connections) 图标都位于此部分的上部。 

 

“WinCC 用户归档提供方”(WinCC User Archive provider) 部分由三个选项卡组成： 

● WinCC 用户归档 

● Where 语句 

● OPC 

 

Where 语句 

 
 

 
说明 

选择 OPC 服务器 
要在“Where 语句”(Where Statement) 选项卡中组态设置，必须先在对话框“触发器提供方 
(页 154)”(Trigger Provider) 中选择一个 OPC 服务器。单击“传送选项”(Transfer options) 
选项卡中的“事件”(Event) 按钮访问此对话框窗口。 

 

 
说明 

列 
根据所选的表格，截屏中显示的列名称可能会有所不同。 
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描述数据读取访问位置的 SQL 字符串显示在此选项卡中。“Where 语句”(Where-
statement) 选项卡主要包括“WHERE”部分和用于显示“生成的 SQL 字符串”(Resulting 
SQL-String) 的文本区域。 

 

 

按以下步骤组态 Where 语句： 

 

1. 单击“添加”(Add) 
按钮打开一个对话框，此对话框所提供的选项可用于选择列以进行内容比较。 

2. 选择要检查特定值的字段名称。所选字段名称显示在“字段名称”(Fieldname) 
字段中。此字段名称的数据类型会在“数据类型”(Datatype) 字段中自动选择。 
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3. 此“字段名称”(Fieldname) 
显示在“WHERE”文本框中。从下拉列表中选择用于比较的运算符符号。 

4. 在“OPC 变量”(OPC-variable) 部分选择 OPC 
变量，其值与之前选择的列条目进行比较。 然后单击“确定”(OK) 按钮。 

5. 条件显示在“Where”部分内的表格中并输入到“生成的 SQL 字符串”(Resulting SQL 
String) 字段中。 

6. 要删除已存在的“生成的 SQL 字符串”，单击“删除”(Remove) 按钮。 

7. 要定义多个条件，请重复第 1 至第 5 步。 

 

 
说明 

SQL 字符串 
 

• 如果组态多个条件，它们以逻辑“AND”连接。 

• 只有在满足条件时才向 IDB 请求数据记录（行）并将其传送。 

• 逻辑“OR”无法实现可选连接。 
 

 

高级： 

使用“高级”(Advanced) 按钮，您可在具有多条数据记录时定义排序顺序及行为。 
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● 排序方式 
选择相应选择字段。然后可定义列名称和排序方向。 

● 对多种结果的行为： 
选择以下选项字段之一，然后单击“确定”(OK) 按钮。 
根据所选的单选按钮，您可决定要执行的操作： 

 

– 错误消息（未传送数据） 

– 提交第一行 

– 提交最后一行 

– 提交所有行 

 

这些选项的标准设置是： 

● 无排序 

● 错误消息（未传送数据） 
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OPC 选项卡 

 
 

 
说明 

OPC 服务器 
要在“OPC”选项卡中组态设置，必须先在对话框“触发器提供方”(Trigger Provider) 
中选择一个 OPC 服务器。 单击“传送选项”(Transfer options) 选项卡中的“事件”(Event) 
按钮访问此对话框窗口。 

 

1. 在“WinCC 用户归档提供方”(WinCC User Archive Provider) 区域的 OPC 
选项卡内，显示 OPC 
变量浏览器。在变量浏览器中，选择应进行值传送操作的变量。所选变量显示在“变量 
ID”(Tag ID) 字段中。根据所选内容选择数据类型。 

2. 如果所选变量为数组数据类型，则自动启用“数组”(Array) 复选框。 
此复选框在“数据类型”(Datatype) 字段下面。 

3. 下一步，按以下步骤组态“动态数据库消费方”(Dynamic Database consumer) 
部分的消费方列： 

– 所选的表格显示在“表格”(Table) 字段中。从“方案”(Schema) 
文本框的下拉列中选择方案（如果适用）。 

– 列名称在“列”(Columns) 
区域中显示。如果表格中有各个数据类型的列，也可将时间戳写入表格。这种情况

下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for timestamp) 
字段中选择该列。 

4. 选择要与 OPC 变量连接的列名称。所选的列显示在“数据值列”(Column for data 
value) 字段中。 

5. 在右侧的“连接映射设置”(Connection mapping settings) 
区域检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 

6. 对要传送的“WinCC 用户归档提供方”(WinCC User Archive Provider) 
所有元素，重复第 1 到第 5 步。 
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说明 

数组 
如果提供方变量的数据类型是数组而数据库消费方列的数据类型不是数组，则单击“连接”(
Connect) 按钮后，“OPC”选项卡中的“数组”(Array) 复选框将自动取消选中。 

 

动态数据库消费方 

“动态数据库消费方”(Dynamic database consumer) 部分显示在“连接映射”(Connection 
mapping) 选项卡的左下部。 此部分位于“WinCC 用户归档提供方”(WinCC User Archive 
provider) 部分之下。 “动态数据库消费方”(Dynamic Database consumer) 
部分中提供了多个选项，可用于选择要映射到 WinCC 
用户归档提供方的方案、表格名称和列名称。 

在 WinCC 用户归档提供方列以及在“Where 语句”(Where statement) 
选项卡中选择的列（属于动态数据库消费方）之间创建一个特定的连接。 
您可创建一个新连接或修改现有连接，以便将“Where 语句”(Where statement) 
应用于所选列。 

 
 

 
说明 

选择方案 

• 如果使用除 Microsoft Access 外的数据库，在选择“表格名称”(Table name) 
之前必须先选择“方案”(Schema)。 

• 将 Microsoft Access 用作数据库时，“方案”(Schema) 
字段显示为禁用状态且不允许选择任何方案。 

 

 

“动态数据库消费方”(Dynamic Database consumer) 由 2 个选项卡组成： 

● 动态数据库 

● Where 语句 
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Where 语句 

要在“动态数据库消费方”(Dynamic database consumer) 区域内选择消费方列，需要组态 
Where 语句。“Where 语句”(Where-statement) 选项卡主要包括“Where 
语句”组态部分和异常处理部分。 

 

如需执行连接映射，执行以下步骤： 

1. 在“WinCC 用户归档提供方”(WinCC User Archive provider) 
部分（左上方），选择要应用 Where 语句的列（动态数据库消费方）。 

2. 选择后，列名称将显示在“数据值列”(Column for data value) 
字段中。数据类型将根据所选列名称自动选择。 

3. 在“Where 列”(Where-column) 字段，选择要用于 Where 语句的列。 
如果要向数据库中写入一个值，则会比较此列与连接的提供方列。 
只更新两个值匹配的行。 

4. 如果在消费方一行中所做选择不唯一，则在“异常处理”(Exception handling) 
字段中定义行为： 

– 错误消息： 不覆盖目标行，发出一条错误消息作为 IDB Runtime 
跟踪视图中的输出。 

– 更改所有行： 覆盖所有已选中的消费方行。 

– 如果不存在带有键（主键）的行，则使用“启用插入”(Enable Insert) 
复选框定义行为。 如果选择此选项，则创建一个带有相应键的新行。 

 
  

说明 

同时用作键列和消费方列 
为了通过组态获得更多的设置功能，可将一个列同时用作键列和消费方列。 
请注意，这将引起数据库中的数据不一致和/或对动态数据库消费方的后续访问可能导

致出错。 
 

5. 在“连接映射设置”(Connection mapping settings) 
区域（右侧）中检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。 单击“连接”(Connect) 按钮确认输入内容。 
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连接映射 

1. 在“WinCC 用户归档提供方”(WinCC User Archive provider) 中，“表格”(Table) 
字段内显示已选择的归档。通过“方案”(Schema) 
字段中的下拉列表为数据库选择方案（如果适用）。 

2. 列名称在“列”(Columns) 
区域中显示。从列表中选择一个列名称。所选的列显示在“数据值列”(Column for data 
value) 字段中。相应的数据类型也会自动显示。 

3. 借助“过滤器”(Filter) 
字段，您可根据列名称的一个字符或前面几个字符来对列名称进行过滤。 

例如，如果要查看以“S”开头的列名称，在“过滤器”(Filter) 
文本框中输入该字符。所有以“S”开头的列名称都将显示出来。  

4. 下一步，按以下步骤组态“动态数据库消费方”(Dynamic database consumer) 
部分的消费方列： 

– 所选的表格显示在“表格”(Table) 字段中。 通过“方案”(Schema) 
字段中的下拉列表为数据库选择方案（如果适用）。 

– 列名称在“列”(Columns) 
区域中显示。如果表格中有各个数据类型的列，也可将时间戳写入表格。 
这种情况下，选中相应的“激活”(Active) 复选框，并在“时间戳列”(Column for 
timestamp) 字段中选择该列。 

5. 在“数据库消费方”(Database consumer) 中选择要与“WinCC 用户归档提供方”(WinCC 
User Archive Provider) 列名称相连接的列名称。 
所选列的数据类型将自动在“数据类型”(Datatype) 字段中显示。 

所选的列显示在“数据值列”(Column for data value) 字段中。 
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6. 在右侧的“连接映射设置”(Connection mapping settings) 
区域检查连接名称。在“连接名称”(Connection name) 
字段中为连接输入一个唯一名称，或使用“默认名称选项”(Default name options) 
中的选项。单击“连接”(Connect) 按钮确认输入内容。 

 
 

  
说明 

数据类型转换 
如果提供方列与消费方列不匹配，IDB CS 
将转换数据类型，使其与提供方的数据类型相匹配。随即将显示出一个状态窗口指示

此项更改。 
 

7. 对要传送的“WinCC 用户归档提供方”(WinCC User Archive Provider) 
所有元素，重复第 1 到第 5 步。 

结果 

已创建的连接显示在 IDB CS“设置”(Settings) 窗口的“连接”(Connections) 
选项卡中和项目树节点中。 
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5.3.4 在 WinCC Runtime 中查看示例 2 

概述 

本章介绍了在 WinCC Runtime 环境下查看入门指南示例 2 所遵循的步骤。 
安装时随附的入门指南项目包括运行示例项目所需的所有资源。 

先决条件 

● 已安装 WinCC V7.3 

● IDB 入门指南项目“idb_getting_started.MCP”已加载到 WinCC 并且项目已激活。 

● IDB CS 应用程序已打开 

● 已在 IDB CS 应用程序中加载“入门指南”项目“IDBProject” 

 

 

导入组态（XML 文件） 

执行以下给出的步骤来导入随 IDB 
入门指南提供的组态文件并组态相应的提供方/消费方类型： 

1. 在 IDB CS 中，选择“项目 > 导入运行系统组态”(Project > Import Runtime 
Configuration) 来导入组态文件。 

2. 在显示的“打开”(Open) 对话框中，浏览到 IDB 入门指南文件夹 (idb_getting_started) 
并选择组态 XML 文件“idb_getting_started_configfile.xml”。 
下一步，单击“打开”(Open) 按钮。 

3. IDB 入门指南项目组态将导入到 IDB CS 中，项目名称会显示为“IDBProject”。 

4. 左侧的项目树显示一个树状结构，其中包含项目、链接和它们的子节点。 
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5. 在 IDB CS 中，对示例 2 项目的相应提供方/消费方模块执行以下设置： 

– 在 WinCC 用户归档提供方/消费方组态中，输入 WinCC 
在计算机中的完整安装路径并选择合适的数据库。 

– 在连接映射选项卡中组态 Where 语句和 WinCC 
用户归档和动态数据库提供方/消费方的高级选项，并创建连接。 

6. 在执行这些步骤后，保存项目并将组态 XML 文件导出到 IDB 入门指南的文件夹 
(idb_getting_started)。 

此 XML 文件将在 IDB Runtime 应用程序中使用。 

 

 
 

 
说明 

打开 IDB 组态 
入门指南项目所需的 IDB 组态也可以在 IDB CS 中使用“IDBProject.ip73”文件来打开。在 
IDB CS 中，单击“项目 > 打开项目”(Project > Open project)，然后单击“浏览”(Browse) 
按钮来浏览文件夹结构。 浏览文件夹中的内容，选择“IDBProject”文件夹中的 .ip73 
文件。 

 

 

在 WinCC Runtime 中查看示例 2 

WinCC Runtime 中显示的示例 2 包括多个用户控件和按钮，以实现数据传送功能。 
提供的文本控件用于在这些字段中输入所需的值。 
该示例包括将配方数据从数据库中下载到 WinCC 
用户归档，然后将生产结果上传到数据库这一过程。 IDB Runtime 
控件位于示例画面的中间，包括若干选项以连接链接和启动数据传送。 
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按照以下列出的步骤来连接组态并启动数据传送： 

1. 在 IDB Runtime 控件中，选择“选项”(Options) 按钮以打开“运行系统组态”(Runtime 
configuration) 窗口。 

2. 在“NT 服务”(NT Service) 选项卡中，单击“启动服务”(Start service) 按钮以启动 IDB 
服务，然后单击“确定”(OK)。 
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3. 下一步，单击“打开”(Open) 按钮，以加载组态文件。 在“打开”(Open) 
对话框窗口中，浏览文件夹内容，选择组态文件“idb_getting_started_configfile.xml”，
然后单击“打开”(Open) 按钮。 

 
  

说明 

IDB Runtime 中显示的连接 
IDB Runtime 窗口显示属于示例 1 和示例 2 
的所有连接（链接）。使用某个示例时，建议您选择特定于该示例的连接（链接）。  

 

4. 随即显示连接列表以及各提供方和消费方的状态。 
在每个提供方/消费方旁，以一个小圆圈来指示状态。 

5. 单击“连接”(Connect) 
按钮，以连接提供方和消费方类型。提供方和消费方的状态随即变成绿色。 

6. 下一步，单击“启动”(Start) 按钮，启动数据传送。 

下载配方数据 

7. 在示例画面左侧的“下载配方数据”(Download recipe data) 
部分，单击“从数据库中获取数据”(Fetch data from database) 按钮。 
从数据库中检索的数据会显示在 WinCC 用户归档控件中。 
在示例画面中，显示的勾号标记图标指示数据已成功传送。 

8. 表格中最后一条更新的记录将显示在“设定值”(Set point) 和“颜色”(Color) 字段中。 
这些字段作为工厂中生产过程的输入。 

上传生产结果 

9. 在“上传生产结果”(Upload production results) 部分，在“使用的材料”(Used material) 
和“操作员姓名”(Operator name) 字段中输入数据并单击“添加新行”(Add row) 按钮。 
每次在这些字段中输入数据时都需要按“Enter”键。 

您可以观察到，输入的数据会显示在 WinCC 用户归档控件中。 

10. 单击“发送用户归档数据”(Send user archive data) 
按钮，将这些生产结果发送到数据库。 
在示例画面中，显示的勾号标记图标指示数据已成功传送。 



 入门指南和示例 
 5.3 入门指南示例 2 
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说明 

在示例 1 和示例 2 之间切换 
单击示例画面右下角的按钮，可以在两个示例之间切换。 
需要特别注意的是，在切换到另一个示例之后，需要在做进一步操作之前停止数据传送并

断开数据连接。 
当准备就绪后，可以开始提供方/消费方类型之间的连接，并启动数据传送。 

 

结果 

您已经成功执行数据传送，并且通过本示例理解了使用 IDB 
来连接组态链接和启动数据传送的步骤。 
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Ｊ 

JScript, 50, 77, 101, 131, 158 

Ｖ 

VBScript, 50, 77, 101, 131, 158 

Ｗ 

Where 语句 
动态数据库, 135 

Ｒ 

入门指南 
WinCC 项目, 9 
任务, 5 
步骤, 5 
启动 IDB, 10 
启动 WinCC, 10 
软件要求, 7 
项目, 9 
要求, 7 
基本操作步骤, 5 
逻辑运算, 5 
硬件要求, 7 
激活项目, 10 

Ｂ 

编程语言, 50, 77, 101, 131, 158 
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